Clinic Management Information System (CMIS)

by

Wong Choong Leong

WEK 990076

Under supervision of

Assoc. Prof. Raja Nor Aion Raja Zainal Abidin

Moderator: Assoc. Prof. Dr. Ow Siew Hock

Session 2001/2002
ABSTRACT

Clinic Management Information System, or in short CMIS is a system that computerize the clinics activities. In the current manual system, lots of problems exist in the management of a clinic. Hand written records are difficult to read. Besides, records are written in papers and placed in the cupboard. There are possibilities that the files misplaced or lost. The stocks of the drugs are difficult to be keeping track. CMIS, however, eliminate most of the problem facing by the manual system. Records are stored securely in the database. Records are easily referred by the users of the system.

CMIS is developed for three types of users who comprise of doctor, staff, and pharmacist. These users have their own restrictions in the system. Only the authorized users are allowed to create, maintain, and make changes, delete or update the data under their respective scope. Validation of the user’s login is indeed needed in order to access to the system. With this system, the daily transactions are all computerized. Making the management running smooth, efficient, accurate, and secured.

The waterfall model with prototyping approach was chosen in the development phase because the strengths of both the waterfall model and prototyping can minimize the risks involved. The development tool chosen in this project is Visual Basic 6.0 with Ms SQL Server as back-end database management system and Windows 2000 as development platform.

Finally, it is hoped that this project will bring a new era in the management of a clinic towards paperless environment.
ACKNOWLEDGEMENT

It is with great pleasure and gratitude that I would like to acknowledge the contributions of several people who helped me and guided me throughout all the planning stages of this project proposal.

First of all, I would like to express my gratitude to my project supervisor, Assoc. Professor Puan Raja Ainon Zabariah for her guidance and valuable advice.

Also, I wish to express my appreciation to my project moderator, Assoc. Professor Dr. Ow Siew Hock for her generous advice and valuable guidance.

Special thanks to Dr Wong Kwan Kit and Ms Sherry for their kindness in freeing some time for my interview session.

Last but not least, I would also like to express my gratitude to all the people who had kindly lending me a helping hand throughout the proposal and development of this project.
# Table of Contents

ABSTRACT ........................................................................................................... i  
ACKNOWLEDGEMENT ......................................................................................... ii  

Table of Contents ................................................................................................... iii  
List of Figures .......................................................................................................... vii  
List of Tables ............................................................................................................. viii  

1 Introduction ......................................................................................................... 1  
1.1 Project Definition ............................................................................................. 1  
1.2 Objectives .......................................................................................................... 2  
1.3 Scope and Limitations ....................................................................................... 4  
1.3.1 Scope of the project ....................................................................................... 4  
1.3.2 Limitations of the project ............................................................................ 5  
1.4 Overview of the system ..................................................................................... 6  
1.5 Expected Outcome ............................................................................................ 7  
1.6 Project Schedule ............................................................................................... 9  
1.7 Hardware and Software Requirements ............................................................ 10  
1.7.1 Hardware .................................................................................................... 10  
1.7.2 Software ..................................................................................................... 10  
1.8 Chapter Summary ............................................................................................ 11  

2 Literature Review ............................................................................................... 12  
2.1 Introduction ..................................................................................................... 12  
2.2 Importance of Literature Review .................................................................... 12  
2.3 What is Information? ...................................................................................... 13  
2.4 What is Information System? .......................................................................... 13  
2.5 Current Clinic Management System ............................................................... 14  
2.6 Computer-based Management Information System ....................................... 16  
2.7 Comparisons between Manual and Computer-based System ....................... 17  
2.8 Review of Existing Software Solutions .......................................................... 18  
2.8.1 Octagon Clinic Manager ............................................................................ 18  
2.8.2 MEDICOM ................................................................................................ 18  
2.8.3 InfoClinic .................................................................................................... 19  
2.9 Comparisons between Existing Software ....................................................... 20  
2.10 Review of Previous Thesis ............................................................................ 21  
2.11 Computer-based Management Information System Benefits ...................... 22  
2.12 Client Server Technology ............................................................................ 23  
2.13 Types of Client Server Technologies .............................................................. 24  
2.13.1 Single Tier Architecture ........................................................................... 25  
2.13.2 Two-Tier Architecture ............................................................................. 25  
2.13.3 Three-Tier Architecture ......................................................................... 26  
2.14 Development Tools and Technologies Consideration .................................. 27
## Table of Contents

5 System Implementation ..................................................................................... 78
  5.1 Introduction ................................................................................................. 78
  5.2 System Development .................................................................................. 78
    5.2.1 Development Tools ............................................................................. 79
      5.2.1.1 Hardware Requirements ......................................................... 79
      5.2.1.2 Software Requirements .......................................................... 79
    5.2.2 Methodology ......................................................................................... 80
    5.2.3 System Coding ..................................................................................... 80
      5.2.3.1 Coding Approach ....................................................................... 80
      5.2.3.2 Coding Style .............................................................................. 81
    5.2.4 System Coding Tool – Visual Basic 6.0 .............................................. 81
    5.2.5 Database Connection ........................................................................... 82
  5.3 Summary ....................................................................................................... 83

6 System Testing .................................................................................................. 84
  6.1 Introduction .................................................................................................. 84
  6.2 Objective of Testing ..................................................................................... 84
  6.3 Testing Technique ...................................................................................... 85
    6.3.1 White Box testing ............................................................................... 85
    6.3.2 Black Box Testing ............................................................................... 85
  6.4 Testing Strategy .......................................................................................... 86
    6.4.1 Unit Testing .......................................................................................... 86
      6.4.1.1 Unit Testing Example ................................................................. 88
    6.4.2 Control Objects Testing ...................................................................... 88
    6.4.3 Different Data Type Testing ............................................................... 89
    6.4.4 Module Testing .................................................................................... 89
      6.4.4.1 Module Testing Example ............................................................ 90
    6.4.5 Integration Testing ............................................................................... 91
    6.4.6 System Testing ..................................................................................... 91
  6.5 Summary ....................................................................................................... 92

7 System Evaluation ............................................................................................ 93
  7.1 Introduction .................................................................................................. 93
  7.2 Problems Encountered and Solutions ....................................................... 93
    7.2.1 Difficulty in Choosing a Suitable Development Tools .................... 93
    7.2.2 Lack of Knowledge in Visual Basic 6.0 .......................................... 94
    7.2.3 Difficulty in Gathering Information ............................................... 95
    7.2.4 Failure in Controlling Date Display Format .................................... 95
    7.2.5 Difficulties in Defining The Flow Logic of the System .................... 95
  7.3 System Strengths .......................................................................................... 96
  7.4 System Constraints ...................................................................................... 98
  7.5 Future Enhancements .................................................................................. 99
  7.6 Knowledge and Experience Gained ........................................................... 100
  7.7 Summary ..................................................................................................... 102
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Conclusion</td>
<td>103</td>
</tr>
<tr>
<td></td>
<td>REFERENCES</td>
<td>104</td>
</tr>
<tr>
<td></td>
<td>APPENDICES</td>
<td>107</td>
</tr>
<tr>
<td></td>
<td>USER MANUAL</td>
<td>111</td>
</tr>
</tbody>
</table>
List of Figures

Figure 1-1: Project's Schedule. ................................................................. 9
Figure 2-1: The component of an information system. ................................... 13
Figure 3-1: How prototyping works. ............................................................ 46
Figure 3-2: A graphical model of the Waterfall Model with Prototyping. .......... 47
Figure 4-1: Context Diagram of CMIS. ....................................................... 65
Figure 4-2: Structure chart of CMIS. ........................................................... 66
Figure 4-3: Zero level DFD for Security Module. .......................................... 67
Figure 4-4: Zero level DFD for Doctor Module. ............................................ 68
Figure 4-5: Zero level DFD for Staff Module. .............................................. 69
Figure 4-6: Zero level DFD for Pharmacist Module. ...................................... 70
Figure 4-7: Login Screen. ................................................................. 74
Figure 4-8: Dispensation. ................................................................. 75
Figure 4-9: About Screen. ................................................................. 76
Figure 4-10: Expired Drug List. ................................................................. 76
Figure 6-1: Unit Testing. ........................................................................... 87
List of Tables

Table 2-1: Comparisons Between Manual and Computer-based System. ............... 17
Table 2-2: Comparisons between existing software. .............................................. 20
Table 2-3: Review of previous thesis. .................................................................. 21
Table 3-1: Server hardware and software requirements. ...................................... 62
Table 3-2: Client hardware and software requirements. ....................................... 62
Table 4-1: Database table of Patient’s Personal Information. ............................. 71
Table 4-2: Database table of Drug’s details. ......................................................... 72
Table 4-3: Database table of Patient’s Disease History. ....................................... 72
Table 4-4: Database table of Patient’s Treatment. ............................................... 72
Table 4-5: Database table of User Details. ......................................................... 73
Table 4-6: Database table of Appointments. ......................................................... 73
Table 6-1: Unit Testing Example........................................................................... 88
Table 6-2: Module Testing Example..................................................................... 90
1 Introduction

1.1 Project Definition

The emergence of Information Technology has ease the jobs of the humans. Many manually operated systems are being computerized in these recent decades. This including manually operated management information system. In Malaysia, there are many clinics still using manual system to manage their patients’ record. This manual system is less efficiency and error-prone. The transformation of manually to computer-based system will certainly ease the job of management as well as reduced the time to manage manually. It also helps to reduce errors, potential risks, waiting time as well as appropriate dispensary.

The computer-based system smoothes the management of the clinic and promote the paperless environment. In additional, the data are stored in a more secured way. Besides, the treatment conducted by the doctor can be input to the computer and stored in the database. The data can be retrieved just by clicking the mouse and the keyboard. No more papers or stationery used to note down the treatment records. Medical professionals (doctors) can easily refer to the patient’s previous treatments and profiles.

Furthermore, the data that are stored in the database is retrieved accurately and quickly. It also eliminates the duplicated data in the database. It will also eliminate the common errors with the manual system. This will surely increase the quality of managing the complete patients’ record as well as improve the availability of patient’s data when needed.
1.2 Objectives

The objectives of this project are:

- **To assist the doctor in ease of recording treatment.**
  The doctor can store and record the current medical treatment of the patient in the computer for future reference. This will eliminate the necessity to write the records and treatments in the papers.

- **To practice paperless environment**
  If the computer-based system is used, fewer papers are needed to record the records. Thus, it can reduce the amount of paper used. Besides, handwritten records might be hard or difficult to see. It is hoped that computer-based system can improve the accuracy, speed, and validity of the records.

- **Easily retrieve data from the database for patient's profiles and treatments.**
  Before the consultation starts, the doctor can easily achieve the patient’s records by clicking the mouse and typing through the keyboard. The data is then retrieved from the database and displayed on the computer’s screen. This can avoid the doctor thumbing through several pieces of paper before he finds what he needs.

- **Data is stored in a more secured way and eliminate the duplicated as well as redundant data.**
  Only the authorize personnel are permitted to access the data. It will also reduce the cost and time in gathering of information of the patients. User is alerted if similar patient name or IC is already present when creating a new patient record. Besides, cases where files are misplaced or lost are avoided.
• **To reduce the amount of time required for searching and handling patient records.**
For the first time visit patient, he has no record. Only the staff will do the registration for him. The staff just needs to key in the information of the patient and save it in the database. Since the data of the patient may change from time to time, the staff can update the patient’s profiles and save it again in the database. Besides, the patient’s record can be search easily and quickly. The record can be easily be obtained by clicking the mouse and typing through the keyboard. This will reduce the waiting time in order to get the record and thus practice effective time management.

• **Printing of useful materials such as medical certificates or official receipt.**
This will ease the job of the doctor to issue a medical certificate. The doctor just needs to print out the medical certificate and sign it. Furthermore, the doctor can print the referral letter for the patients who need further treatment from other doctors. The staff can print the official receipts and collect the payments in the counter. Also, the pharmacist can print the drug’s summaries and labels.

• **Dispensation of the medicine to the patient is accurate.**
The medicines that will be dispensed to the patient are accurate in their usages and dosages. The doctors will also aware what kinds of medicines are given before.

• **Drugs Inventory**
It will help the pharmacist to automatically update inventory quantities of the available drugs. It saves the pharmacist’s time from counting the quantity one-by-one. The drugs’ details are stored in the database. The details include information about the drugs, their suppliers, precautions and etc. Drugs can be added to or deleted from the list from time to time. Besides, alert message is generated once the quantity of a drug is less than a certain limit.
1.3 Scope and Limitations

1.3.1 Scope of the project

The coverage of this system is all kinds of patient-oriented data administration in a clinic. The implementations of the system make all the affairs of the clinic integrated electronically. The development of the system is focused to the potential users that are consisting of the medical professional (doctor), and administration staff, and pharmacist.

The scope that will covered by the system includes:

* Login to verify only the authorized person can access the system.
* Develop an administration system to maintain patients’ data and profiles.
* Develop a database system to store the data in a secured and accurate way.
* Recording data by the medical professionals, staff and pharmacist.
* Printing of useful materials such as official receipts, drugs’ summary, medical certificates, and referral letters.
* Drug inventory.
* Basic financial function.
* E-mail function.
* Generating of graph for analysis purpose.
1.3.2 Limitations of the project

This project carries some of the limitations as followed:

- This system does not provide panel doctor function for the companies.

- The financial function is limited to calculate simple daily, monthly, and yearly incomes as well as the expenses of the clinic.

- The appointment system is limited to the patients who need further treatments from the clinic.

- The system will not generate any document about patients’ profiles and their medical records.

- Graph generation is limited for patients’ ratio and incomes analysis.
1.4 Overview of the system

The system developed in this project, which is named, “Clinic Management Information System” is a stand-alone system that completely integrated the management of a clinic electronically. Traditionally, manual system is practice in the management. This type of management is prone to errors and time consuming. Besides, files and patients’ medical cards are just stored in a cabinet. These files and cards may misplace or lost. It also arises many security problems.

The system, here, well-suits three types of users. These potential users include the doctor, staff, and pharmacist. Only the authorizes users are allowed to create, maintain, make changes, delete or update the data under their respective scope. Validation of the user’s login is indeed needed in order to access to the system. With this system, the daily transactions are all computerized. Making the management running smooth, efficient, accurate, and secured.

If the manual system is practiced, it is difficult to maintain and update the numbers of record. With the implementation of the database, the records are stored in an easy, secured, and systematic way for future reference. Functions provided for this system included the basic needs of a clinic. Printing of medical certificate, receipts, display of the patient’s data and profiles are instances that will be included.

It is hoped that this system will reduce the workload of a clinic and hence increase the performance of the management of a clinic. In short, Clinic Management Information System will carry lots of benefits to all of the users mentioned above if the right solutions are performed, systematically deployed and carefully implemented.
1.5 Expected Outcome

The expected outcomes for this project is as followed:

- Acceptable respond time when the data are keyed in or retrieved from the database.
- Simple and user-friendly system as it is easy to navigate.
- The capabilities to upsized the database for the advance functions as well as the patients’ record.
- Provide a more effective and efficient way of sharing data and overall system.
- Data input will be examined and errors will be reported.

The system will also consider a few users’ prospective. This includes the doctor’s prospective, staff’s prospective and pharmacist’s prospective.

The doctor’s prospective:

- User is required to log in using their username and password to the system.
- User is required to log out from the system after using it.
- User can input the treatment and medical records of a patient to the database.
- User can obtain and view the patient’s profiles and past treatment and previous medical records easily.
- User can also search the patient’s profiles.
- User can record the prescription of the drugs in their dosages and usages of a patient for future reference.
The staff's prospective:

- User is required to log in using their unique id and password before they can proceed to create and update the patients’ profiles as well as the medical reports.
- User is required to log out from the system after using it.
- User is possible to search and look for a patient’s record by inputting his/her patient ID.
- Ease of daily transactions such as printing of medical certification and billings receipt.

The pharmacist's prospective:

- Pharmacist is responsible for dispensing the correct medicine for the patient through the system.
- Inventory of drugs such as update of drugs’ quantity is handled by the system.
  Information of the drugs is stored in the database.
- User can print drug’s summaries and labels.
1.6 Project Schedule

A project schedule that consists of the whole development's activities is carefully planned out to achieve a systematic progress and ensure on-time delivery of the product. It is important to have a project as it acts as a time-management and control to the developer to ensure that he is in route of the direction of the project:

![Figure 1-1: Project's Schedule.](image-url)
1.7 Hardware and Software Requirements

The following is a list of hardware and software that will be needed for system development.

1.7.1 Hardware

- Intel Pentium or AMD K6-2
- 10 GB of hard disk space
- 128 MB RAM
- Printer

1.7.2 Software

- Microsoft Windows 2000 Professional with service pack 2
- MS SQL Server 7.0
- Microsoft Visual Basic 6.0
1.8 Chapter Summary

This chapter describes the project to be developed. The objective of the project is to develop a system that can ease the management of a clinic. Besides, the scope of the project is discussed briefly in this chapter. The project’s scope is the coverage of the project. It describes what is done by the system.

However, the project also carries some of the limitations that will not be covered in this development phase. An overview is included in this chapter. It is hoped that it can give a clear description about the system to be developed. Expected outcomes will provide a guideline in order to develop a system that will meet the users’ requirements.

The project schedule is included in this chapter too. It is a time arrangement towards the completion of the project. This chapter also stated the facilities that are needed for the development purpose.
Chapter 2 Literature Review

2 Literature Review

2.1 Introduction

In the process of developing an existing or newly system, lots of activities need to be carried out. Researches become the most important and major activity before the development phases start. Research ought to be carried out in order to study the problem thoroughly. It also should be performed until completely understanding the system is reached. The studies in this project have reviewed the different between the manual and computerized management information system. It also presents the advantages that will be beneficial from the information system.

2.2 Importance of Literature Review

Literature review is important to a project as it places the project in the context of others, which might have similar characteristics. It also helps to understand the existing features that are offered by a similar system. Besides, literature review also assists to equip the developers with some knowledge of the strength and limitations of several development tools and technologies in the market. This will help the developers to choose the right tool to build up the system.
2.3 What is Information?

Information system operates to manipulate data. Data is raw material, recorded, unformatted data. Most data items have little meaning and use by themselves. Data formatted with dashes or label is more useful. It is transformed into information that can be defined as a representation of reality [1]. Information is data that has been processed so that an action or decision can be made from it. Therefore data and information are an important part of a computer system. A computer exists to convert data into information.

2.4 What is Information System?

Information system is combination of hardware, software, and telecommunications networks that people build and use to gather, create, and distribute useful data for organizations. Information system is used within organizations to process transactions, management, administration, and other processes [1]. Figure below show the components of an information system.

![Diagram of an information system](image-url)

*Figure 2-1: The component of an information system.*
2.5 Current Clinic Management System

Although Malaysia is marching towards the vision 2020 and the MSC status, most of the clinics throughout the country are still operated or managed medical information manually. Patients’ profiles and medical records are saved in the file and stored in the cabinet. When the patient visits the clinic or coming for consultation, they have to show their registration card or identity card to the receptionist. Each patient owns a unique registration number. After the patient has registered to the receptionist, the staff will search the patient’s files in the cabinet based on the registration number or their name if they forget to bring along the registration card.

After the file is found, the patient will be given a queuing number. And the file will pass to the doctor in the room. Traditionally, the doctor will record the treatment in hand-written progress in the file. While pen and paper are easy and common to use, hand-written information is neither structure nor coded. Thus, it is difficult to use for automated decision support, researches, and outcomes analysis.

The file then sends to the drug dispensary department to provide the patient the medicine. This will involve the file travel from the doctor to the dispensary department. Besides, pharmacists will have to always check the quantity of the remaining drug inventory after certain period of time.

The overall operating of a clinic consumes a considerable of time from registration, searching for patient’s record, until to the pharmacist. The common deficiencies in the manual system are as followed:

- Data are stored in the files and placed in the cabinet

In the manual system, patients’ profiles and data are stored in the paper files. The files are then arranged according to the patient’s first name and placed in the
cabinet. It will take time for the staff to search the file when the patient comes to visit the doctor. If a file is misplaced, then the staff will take a considerable of time to search for it.

- Patient’s profiles and medical records are written in the papers
  The record is written in the piece of papers. When the paper is fully written, a new paper is inserted. Then the papers are kept in the file. This has the probability of losing one of these papers. If the paper is lost, the medical records will lose too.

- Receipts
  In the current practice, receipt will only be given if the patient asks for it.

- Drug Inventory
  Current manual system does not have drug inventory system. This is difficult for the pharmacist to keep track the stock of the drugs.
2.6 Computer-based Management Information System

Using the computer technologies, many systems are being computerized. The use of computers in the industries, businesses, or personal uses reduce the overall responsibilities of the human. Computer technologies are also able to assist in the clinic operations. All of the data are stored in the database.

When patients come to clinic for treatment, they need to show their registration card or give their name to the receptionist. The receptionist will input their data through the keyboard and quickly the patients’ records will be shown in the screen of the computer. This would certainly save a lot of time searching for patients’ record compared to the manually operated system. Once the record is displayed, a queuing number will be generated to the patient. And the patient is put in the waiting list. If a new patient comes, registration is carried out. All the data are input through a standard form through the keyboard and a new record is created for that particular patient.

Also, the record of the patient is displayed on the computer screen in the doctor’s room. All the treatment, diagnostic and prescription of medicine to the patient can key in through the keyboard and save in the database easily. Prescriptions are forwarded to the pharmacist. Pharmacist can base on the information displayed and gives the appropriate medicine to the patient. This will indeed reduce errors, potential risks, and patients’ waiting time.

The management of the drugs also benefits from the computerized system. The drugs inventory will automatically update after the medicine is giving away to the patients. Pharmacist can know the quantity of the drugs by just clicking a few keyboard buttons rather than to check the remaining one by one. All are provided in an accurate manner and thus improve the overall system of a clinic.
### 2.7 Comparisons between Manual and Computer-based System

The comparisons between the manual operated and computer-based system are as followed:

<table>
<thead>
<tr>
<th>Manual System</th>
<th>Computer-based System</th>
</tr>
</thead>
<tbody>
<tr>
<td>i. Records are written in papers and stored in cabinet or cupboard.</td>
<td>i. Records are stored in database.</td>
</tr>
<tr>
<td>ii. Time is needed to search the record from the place where the record is stored.</td>
<td>ii. Records can be search easily through clicking the mouse or typing through keyboard.</td>
</tr>
<tr>
<td>iii. Records may be misplaced or lost.</td>
<td>iii. Records are stored safely and securely in the database.</td>
</tr>
<tr>
<td>iv. Handwritten records may be difficult to read or analyze.</td>
<td>iv. Records are stored in standard fonts and size and easily to read.</td>
</tr>
<tr>
<td>v. Reports for drugs summary are difficult to be generated. Lots of effort is needed to generate the reports.</td>
<td>v. Reports for drugs summary are easily to be generated.</td>
</tr>
<tr>
<td>vi. The management is based on person. If the staff quits, new staff needs a lot of time to pick up what the system the previous staff did.</td>
<td>vi. The management is based on system and not any particular person. It is easy for new staff to learn the system.</td>
</tr>
<tr>
<td>vii. Paper work is important.</td>
<td>vii. Less paper work is involved.</td>
</tr>
<tr>
<td>viii. It is difficult for doctor to follow up the patient since there are too many records.</td>
<td>viii. Easy for doctor to follow up the patient because the record can be easily to retrieve from the database.</td>
</tr>
</tbody>
</table>

*Table 2-1: Comparisons Between Manual and Computer-based System.*
2.8 Review of Existing Software Solutions

2.8.1 Octagon Clinic Manager

OCM is a clinic management system that is designed to help to manage the clinic. It has the flexibility to run under a standalone PC or under a network to allow sharing of information between different users. OCM is an integrated clinic management system that allows users to do billing or patient's record or print receipt, drug label, MC, etc. OCM offers many different modules such as Patient's Module, Billing Module, Drug's Module, and Reports Module. OCM runs on standalone PC under DOS or Windows 95/98 [2].

2.8.2 MEDICOM

MEDICOM is a real-time, on-line, integrated information management system for healthcare establishments, addressing all critical areas of health care activity. MEDICOM is modular and flexible. The various modules are fully integrated (but can also standalone) to automate functions ranging from patient administration to clinical services. The services offered by MEDICOM include Patient Administration Services, Patient Care Services, Specialist Services, Management Information Services, Financial and Administrative Services, and Support Services.

MEDICOM provides immediate access to clinical and administrative data, streamlines the scheduling and management of clinics visits and admissions. MEDICOM aids the dispensing of medications, facilitates management of laboratory functions with interfaces to laboratory equipment and much more [3].
2.8.3 InfoClinic

InfoClinic™ is a comprehensive healthcare management system designed to meet the administrative, clinical, and financial management needs of any type and size of healthcare organizations. InfoClinic™ is an Electronic Medical Records System that allows patient information, both clinical and non-clinical, to be updated, stored and reviewed electronically. It is based on a patient oriented management system, where all of a patient's records are referenced to specific problems particular only to that patient.

InfoClinic™ empowers healthcare providers to manage their daily tasks including scheduling, patient encounter and follow up functions, and a comprehensive range of statistical, financial and management reports to facilitate timely and well informed decision making. InfoClinic™ is a state-of-the-art system providing a totally integrated solution. As a result it substantially improve productivity while reducing bottleneck and enhancing reporting times [4].
2.9 Comparisons between Existing Software

The reviews among existing software solutions are as followed:

<table>
<thead>
<tr>
<th>Existing Software Solutions</th>
<th>Clinic Management Information System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Octagon Clinic Manager</td>
<td>i. CMIS is running under Windows 2000 that is more stable and reliable.</td>
</tr>
<tr>
<td>i. OCM runs on PC under DOS or Windows 95/98.</td>
<td>ii. Provides basic but sufficient functions that are needed by a clinic.</td>
</tr>
<tr>
<td>ii. Provide too much functions that a clinic may not use some of them.</td>
<td>iii. Generate graph for analysis purpose.</td>
</tr>
<tr>
<td>iii. Does not generate graph for analysis purpose.</td>
<td>iv. Using Microsoft SQL Server 7.0 that can be deployed at a lower cost and in less time.</td>
</tr>
<tr>
<td>MEDICOM</td>
<td>i. Using Oracle relational database system that is more expensive to implement and need special knowledge to be more familiar with Oracle database management.</td>
</tr>
<tr>
<td>i. Using Oracle relational database system that is more expensive to implement.</td>
<td>ii. Provide too much functions that a clinic may not use some of them</td>
</tr>
<tr>
<td>ii. Provide too much functions that a clinic may not use some of them.</td>
<td>iii. Does not generate graph for analysis purpose.</td>
</tr>
<tr>
<td>InfoClinic</td>
<td>i. Using Oracle relational database system that is more expensive to implement.</td>
</tr>
</tbody>
</table>

Table 2-2: Comparisons between existing software.
2.10 Review of Previous Thesis

Research is done on previous thesis to gather information for the system to be developed. The following are the reviews of the previous thesis:

<table>
<thead>
<tr>
<th>Previous Thesis</th>
<th>Clinic Management Information System</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Medical Information System</strong></td>
<td></td>
</tr>
<tr>
<td>i. No financial function.</td>
<td>i. Provides basic financial function for clinic.</td>
</tr>
<tr>
<td>ii. Does not generate graph for analysis purpose.</td>
<td>ii. Generating graph for income and patients’ ratio analysis.</td>
</tr>
<tr>
<td>iii. No review among existing software solutions and manual system.</td>
<td></td>
</tr>
<tr>
<td><strong>Sistem Pengurusan Maklumat Pesakit Klinik Utama</strong></td>
<td></td>
</tr>
<tr>
<td>i. No financial function.</td>
<td></td>
</tr>
<tr>
<td>ii. Does not generate graph for analysis purpose.</td>
<td></td>
</tr>
</tbody>
</table>

*Table 2-3: Review of previous thesis.*
2.11 Computer-based Management Information System Benefits

It is realized that the fast development in the computer technologies bring a lot benefits to the human. In this case, the clinic management information system uses information system to deal with patients, such as registration, update profiles, billings, drug inventory, and etc. Some of the benefits seek to achieve through information system include:

- Increased efficiency
- Fewer errors
- More accuracy
- Superior control and operations
- Efficiency management and administration
2.12 Client Server Technology

Client server technology is a means of separating the functions of an application into two or more distinct parts. In its most fundamental form, client/server involves a software entity (client) making a specific request that is fulfilled by another software entity (server). The client process sends a request to the server. The server interprets the message and then attempts to fulfill the request. In order to fulfill the request, the server may have to refer to a knowledge source (database), process data (perform calculations), control a peripheral, or make an additional request of another server. In much architecture, a client can make requests of multiple servers and a server can service multiple clients.

The relationship between client and server is a command/control relationship. In any given exchange, the client initiates a request and the server responds accordingly. A server cannot initiate dialog with clients. Since the client and server are software entities they can be located on any appropriate hardware. A client process, for instance, could be resident on a network server hardware, and request data from a server process running on another server hardware or even on a PC. In another scenario, the client and server processes can be located on the same physical hardware box.
2.13 Types of Client Server Technologies

When considering a move to client/server computing, whether it is to replace existing systems or introduce entirely new systems, practitioners must determine which type of architecture they intend to use. The vast majority of end user applications consist of three components: presentation, processing, and services. The client/server architectures can be defined by how these components are split up among software entities and distributed on a network. There are a variety of ways for dividing these resources and implementing client/server architectures. The most popular forms of implementation are of two-tier and three-tier client/server computing systems.

It is also important to understand the general software architecture. Most of the application programs have three major layers, which are composed of presentation layer, business logic or functionality or application layer, and services layer. They are separated such that the software for any one of the pieces (tiers) could be replaced by a different implementation without interference the other tiers. Presentation layer provides the human/machine interaction (the user interface).

The presentation layer handles input from the keyboard, mouse, or other device and output in the form of screen displays. The Functionality or Application layer gives the application program its character. It provides functionality, connectivity, and database servers. This layer also serves as the bridge between the first and third tier. Services layer provides the generalized services needed by the other layers, including such things as file services, print services, communications services, and, perhaps most important, database services [14].
2.13.1 Single Tier Architecture

The number of tiers in a client/server application is determined by how tightly or loosely the three program layers are integrated. A one-tier application is one in which the three program layers are tightly connected. In particular, the presentation layer has intimate and detailed knowledge of the database structure. The application layer is often interwoven with both the presentation layer and the services layer. All three layers, including the database engine, almost always run on the same computer. One-tier applications are easy to design and write, especially with today’s modern software tools [14].

2.13.2 Two-Tier Architecture

In this implementation, the three components of an application (presentation, processing, and services) are divided between two software entities (tiers): client application code and database server. A robust client application development language and a versatile mechanism for transmitting client requests to the server are essential for a two-tier implementation. Presentation is handled exclusively by the client, processing is split between client and server, and data is stored on and accessed via the server. The PC client assumes the bulk of responsibility for application (functionality) logic with respect to the processing component, while the database engine - with its attendant integrity checks, query capabilities and central repository functions - handles data intensive tasks. In a data access topology, a data engine would process requests sent from the clients.

The most compelling advantage of a two-tier environment is application development speed. In most cases a two-tier system can be developed in a small fraction of the time it would take to code a comparable but less flexible legacy system. Most two-tier tools are also extremely robust. These environments support a variety of data structures, including a number of built in procedures and functions, and insulate
developers from many of the more mundane aspects of programming such as memory management. System security in the two-tier environment can be complicated since a user may require a separate password for each server accessed. The proliferation of end-user query tools can also compromise database server security [13].

2.13.3 Three-Tier Architecture

The three tier architecture attempts to overcome some of the limitations of the two-tier scheme by separating presentation, processing, and services into separate, distinct software entities (tiers). The same types of tools can be used for presentation as were used in a two-tier environment, however these tools are now dedicated to handling just the presentation. When the presentation client requires calculations or data access, a call is made to a middle tier functionality server. This tier can perform calculations or can make requests as a client to additional servers. The middle tier servers are typically coded in a highly portable, non-proprietary language such as C. Middle-tier functionality servers may be multi-threaded and can be accessed by multiple clients, even those from separate applications.

Having separate software entities can allow for the parallel development of individual tiers by application specialists. The three-tier architecture also provides for more flexible resource allocation. Middle-tier functionality servers are highly portable and can be dynamically allocated and shifted as the needs of the organization change [13].
2.14 Development Tools and Technologies Consideration

2.14.1 Operating System

Software designed to control the hardware of a specific computer system in order to allow users and application programs to employ it easily. The operating system mediates between hardware and applications programs. It handles the details of sending instructions to the hardware and allocating system resources in case of conflicts [8].

Operating system is the collection of programs that forms the foundation for the basic operations of the computer hardware. It also performs and coordinates the interaction between hardware devices (for example, the CPU and the monitor), peripherals (for example, printers), and application software (for example, a word processing program). In general, there are many different kinds of operating systems found in the market. Below are the descriptions of some popular operating systems.

2.14.1.1 UNIX

Unix is one of the most popular operating system worldwide because of its large support base and distribution. It was originally developed as a multitasking system for minicomputers and mainframes in the mid 1970s, but it has since grown to become one of the most widely used operating system anywhere. It is also a command-line based operating system. The multiprocessing, multitasking, and networking capabilities of NT’s I/O Manager, Object Manager, and Process Manager are taken in a large way from Unix’s architecture, as well as from VMS designs.

Unix supports Remote Procedure Call (RPC), which allows systems to offload computing tasks to another networked CPU. Unix, like NT, is designed with 32-bit
software architecture. Its multitasking and multi-user capability makes it possible to run many different applications at the same time on one computer. Unix has a reputation for being stable and reliable operating system.

2.14.1.2 LINUX

Linux is an operating system that was initially created as a hobby by a young student, Linus Torvalds, at the University of Helsinki in Finland. Linus had an interest in Minix, a small UNIX system, and decided to develop a system that exceeded the Minix standards. Linux’s source code is freely available to everyone. However, Linux does charge for its assorted distributions. This means that companies and developers may charge money for it as long as the source code remains available [7].

Linux is open. This means that for the entire base system, which includes the kernel, the GNU tools, and all the basic utilities, the programmers and users have access to the source code as well as the right to modify it. Therefore, one of the greatest advantages of Linux is that it is the freedom to modify the existing code makes it a very easily extensible platform.

Linux may be used for a wide variety of purposes including networking, software development, and as an end-user platform. Linux is often considered an excellent, low-cost alternative to other more expensive operating systems. Linux remains one of the most stable and reliable operating systems available. Security, which is necessary for protection of sensitive information, is built into Linux at selectable levels.
2.14.1.3 Windows NT

Windows NT has the same graphical user interface as Windows 95. Windows NT is designed around 32-bit software architecture (the Win32 subsystem). It is functioning in a networked environment. Windows NT can communicate with many different types of computers and can secure sensitive data and keep unauthorized users off the network.

Windows NT is designed from the ground up to be the most integrated, comprehensive, and easy server operating system and to provide several premises such as scalability, reliability, and manageability necessary for mission-critical applications. It also provides total solutions in Intranet and Internet services and to mission-critical applications support and all these services are built into the operating system.

Windows NT also provides an outstanding platform for a wide range of services and applications and to be superb, high-performance, high-availability network operating system. It includes features designed to make it easy to install, use, and manage than ever before. Besides, it has fault tolerant feature by supporting Redundant Array of Inexpensive Disks (RAID) technology that provides data protection. This can help prevent web server from easily crash due to hard disk failure. Windows NT also includes a Web-based administration tool that makes the features of the NT administrative tool suite available through any Web browser.
2.14.1.4 Windows 2000 Server

Windows 2000 server is aimed to small-to-medium business. It can function as a web server or a workgroup or branch office server. It is also can be part of a two-way symmetric multiprocessing system. Its most significant new feature is Microsoft's Active Directory, which among other capabilities, enable a company to set up virtual private network, to encryption data locally or on the network, and to give users access to shared files in a consistent way from any network computer.
2.14.2 Programming Language

Nowadays computers are capable of performing many different tasks, from simple mathematical operations to sophisticated graphical representations. These different tasks are not made by the computer itself, these are performed following a series of predefined instructions that conform a program. A programming language is an artificial language for expressing computer programs. An artificial language consisting of a vocabulary along with grammatical rules used to write a set of instructions that can be translated into machine language and then executed by a computer. Machine language is the language the computer actually understands. Each different type of CPU has its own unique machine language [8].

2.14.2.1 Microsoft Visual Basic 6.0

Visual Basic 6.0 is one of the products in Microsoft Visual Studio Package. It allows users to develop Windows application quickly and easily without being expert in other programming languages. Visual Basic provides a graphical environment in which user can visually design the forms and controls that building blocks of applications.

Visual Basic supports many tools, especially to build 3-D Windows “look and feel” interface that will help users be more productive. The tools are not limited to, projects, forms, class objects, templates, custom controls, add-ins, and database managers, users also can use the tools together to create complete applications in months, weeks, or even days; producing an application using another language can take much longer [17].
Some of the Visual Basic 6.0’s features and advantages are as followed:

- Easy to use and has fast development period.
- Visual Basic 6.0 provides more of the actual code for a programmer than any other non-visual programming language.
- The built-in interface creation capability furthers the standardization on the user interface to Windows applications.
- Saving the users’ time by eliminating time spent for writing code to create the user interface to his applications (the visual interface).
- Tools that perform a full range of development tasks.
- Templates (code, property, control) that allow users to reuse code, control property sets, and entire controls with their associated code.
- An enhanced design time environment. The IDE Function Library gives the users instant working code. And the formatter object and expanded Object browser provides users access and work with code in new, innovative, and faster ways.
- A macro facility that lets users to create their own tools without the overhead of the VB6 Add-in Model.

2.14.2.2  Java

At the heart of all the Java talk is the Java programming language. Java is an object-oriented programming (OOP) language that uses many common elements from other OOP languages, such as C++, but it adds some enhancements to make programming Java easier. Like any other language, Java has a particular syntax, a structure for programs, and many supporting applications. The Java Developer’s Kit (JDK) contains all of the tools necessary to create applications (or Web applets) using the Java programming language.
Java is largely based on the C++ programming language. Also, Java is designed to include the functions of a high-level programming language while eliminating some of the more difficult aspects of coding in C++. Java objects are also designed to make programming easier. Everything in Java is based on the object model. This functionality was deliberately built in Java to help speed up Java development in the long run [18].

According to Sun Microsystems, Java is "simple, object-oriented, statically typed, compiled, architecture neutral, multi-threaded, garbage collected, robust, secure, and extensible. The following will list out some of the Java's attributes and advantages:

- **Simple**
  The simplicity of Java is enhanced by its similarities to C and C++. Java has simplified C++ programming by both adding features beyond those found in C++ and by removing some of the features that make C++ a complicated and difficult language to master. Java is simple because it left out many of the unnecessary features of other high-level programming languages.

- **Object-oriented**
  In its approach to object-orientation, Java follows more closely along the lines of languages such as SmallTalk than C++. Just like C++, Java uses classes to organize code into logical modules. At runtime, a program creates objects from the classes. Java classes can inherit from other classes. Except for its primitive data types, everything in Java is an object. Java's support for object-orientation does not include multiple inheritances.

- **Multi-threaded**
  A multithreaded program is one that is written such that it performs more than one task at a time. Java programs can contain multiple threads of
execution, which enables programs to handle several tasks concurrently. All applications have at least one thread, which represents the program's main path of execution.

- Robust
Because the Java interpreter checks all system access performed within a program, Java programs cannot crash the system. Instead, when a serious error is discovered, Java programs create an exception. This exception can be captured and managed by the program without any risk of bringing down the system.

- Secure
Closely related to Java's robustness is its focus on security. Because Java does not use pointers to directly reference memory locations, as is prevalent in C and C++. Therefore, programs cannot gain access to areas of the system for which they have no authorization. Thus, Java has a great deal of control over the code that exists within the Java environment.

- Platform Independent
Platform independence is another way of saying that Java is architecture neutral. Platform independence is the capability of the same program to work on different operating systems; Java is completely platform independent. This means that Java programs don't care what system they're running on.
2.14.2.3 C++

In the early 1980, Bjarne Stroustrup at AT&T Bell Laboratories designed C++ as an extension to the C language, providing data abstraction and object-oriented programming facilities. Stroustrup designed the language to remain compatible and comparable with C in terms of syntax, performance and portability. The C++ language provides key capabilities and benefits offered by object-oriented programming. C++ excludes features that would constrain its use to a limited set of application domains and environments. The mechanisms are defined to allow highly efficient implementations and versatility offered by the language [16].

Some of the C++’s features and advantages are listed below:

- Object-oriented programming
  The possibility to orientate programming to objects allows the programmer to design applications from a point of view more like a communication between objects that on a structured sequence of code. In addition it allows the reusability of code in a more logical and productive way.

- Portability
  The same C++ code can be compiled in almost any type of computer and operating system without making changes. It is obvious that C++ is one of the most used and ported to different platforms programming language.

- Brevity
  Code written in C++ is very short in comparison with other languages, since the use of special characters is preferred before key words, saving effort (and prolonging the life of our keyboards).
- Modular programming
An application's body in C++ can be made up of several source code files that are compiled separately and then linked together. Saving time since it is not needed to recompile the complete application when making a single change but only the file that contains it. In addition, this characteristic allows to link C++ code with code produced in other languages like Assembler or C.

- Speed
The resulting code from a C++ compilation is very efficient, due indeed to its duality as high-level and low-level language and to the reduced size of the language itself.
2.14.3 Database

A database is a store of information. It is a self-describing collection of integrated data. It is self-describing because it contains a description of itself in a data dictionary [12]. The data is stored in tables and categorized by fields. Each group of information is a record. A database can be searched or queried to find the data required. Because data is generally retrieved via a query, the data itself does not need to be entered in any particular order.

2.14.3.1 Microsoft Access 2000

Microsoft Access provides users with one of the simplest and most flexible DBMS solutions on the market today. Regular users of Microsoft products will enjoy the familiar Windows “look and feel” as well as the tight integration with other Microsoft Office family products. An abundance of wizards lessen the complexity of administrative tasks and the ever-present Microsoft Office Helper is available for those who care to use it. Against other desktop database packages Access has one huge advantage. Access integrates well with Microsoft Office packages and data transfer between Access and the other Office components is relatively easy.

In addition, against the other desktop databases Access is both rich in features and powerful. Microsoft Access is a desktop database package. It is not designed to compete with systems such as Oracle or SQL Server - full database servers - whose engines are superior in terms of speed and multi-user capabilities. Microsoft Access is a relational database. This type of database has a much more complex design which, in turn, offers much more functionality and power. The downside is that an effective relational database needs to be designed properly.
Some of the features and the advantages that Microsoft Access poses are as followed:

- **Making Information Easy to Find and Use**
  Access 2000 continues to offer an easy-to-use tool for easily finding information that provides consistency and integration with the other applications in the Office suite.

- **Web-Enabled Information Sharing**
  Access 2000 allows easily sharing information via the corporate intranet and the ability to easily host a database within the browser. This combines the power of a desktop database with the power of the web.

- **Powerful Solutions Tools for Managing Information**
  Power users and developers may now create solutions that combine the ease-of-use of the Access interface (client) with the scalability and reliability of SQL Server.

- **User-friendly forms interface**
  Microsoft Access allows users to enter information in a graphical form and have that information transparently passed to the database. This method is less intimidating for the data entry operator but requires a little more work on the part of the database administrator.

- **Generating of summaries.**
  Reports provide the capability to quickly produce attractively formatted summaries of the data contained in one or more tables and/or queries. Reports allow the inclusion of graphics, attractive formatting and pagination.
2.14.3.2 Microsoft SQL Server 7.0

Microsoft SQL Server 7.0 offers a solution that's aimed at rapid development and low-cost implementation. Microsoft SQL Server 7.0 run limited on Windows based platform. Built-in Internet integration allows users to conduct business on the Internet and build intranet sites. Microsoft SQL Sever 7.0 has increased many fronts depending to the previous versions, and terabyte database are supported. SQL Server 7.0 leads in price-performance by reducing administrative overhead and lowering total cost of ownership with a design that is geared toward dynamic configuration.

Many of the day-to-day manual tasks of the database administrator have been automated. Dynamic locking, dynamic memory allocation, auto-grow tempdb, auto-grow log files, auto-grow database files, automatic creation of the database upon a restore, automatic index creation across an entire database, and many other new features help eliminate administrative tasks. Microsoft SQL Server 7.0 minimizing complexity for users, administrators, and developers allows application to be deployed at a lower cost and in less time.

The most significant advantage of the Microsoft SQL server is the wide variety of third party client support client support available, from those designed strictly for application development to add-in SQL server access modules for standard PC-based DBMSs such as Paradox and dBASE. There are even access modules that let users query the database from leading spreadsheet program. [6].
Some of the Microsoft SQL Server’s features and advantages are listed in the following [10]:

- Easy access to data through the Web
  Users can use HTTP to send queries to the database, perform full-text search on documents stored in database, and run queries over the Web with natural language.

- Highly Scalable and Reliable
  SQL Server with scale up and scale out capabilities meets the needs of demanding e-commerce and enterprise applications.

- Integrated and extensible analysis services
  Users can build end-to-end analysis solutions with integrated tools to create value from data. Additionally, users can also automatically drive business processes based on analysis results and flexibly retrieve custom result sets from the most complex calculations.

- Simplified management and tuning
  It is easy to manage databases centrally alongside all enterprise resources. Stay online while easily moving and copying databases across computers or between instances.

- Quick development, debugging, and data transformation
  SQL Server features the ability to interactively tune and debug queries, quickly move and transform data from any source, and define and use functions. Users can visually design and code database applications from any Visual Studio tool.
2.14.3.3 Oracle

Oracle platform is available for multiple operating systems and research proved that Oracle runs great on Unix. Oracle is more standards-based as well with a set of neat features. Oracle databases are as powerful as the users want them to be. Oracle also is able to efficiently utilize hardware platform that and manage multiple high-speed processors, clustered servers, high bandwidth connectivity and fault tolerant storage technology. Java application can run perfectly with combination of Oracle database.

Oracle also provided the users with more power and flexibility with the database to meet the user requirements. Oracle able handles a rapidly expanding amount of users and/or data gracefully.

One of the disadvantages is Oracle has weird concepts and names as well. As a result, users have to be undergoing specialized training/knowledge to be more familiar with Oracle database management; even the experts of other DBMS, like Microsoft SQL Server and Microsoft Access. Besides, Oracle needs a costly start-up solution of database management. Besides, total of ownership is high for Oracle [11].
2.15 Chapter Summary

In this chapter, literature review is carried out. Literature review helps to understand the system to be developed as well as the tools using to develop this system. The manual system has plenty of efficiencies and thus need a computerized system to get rid of the errors. The comparison was being carried out between the manual system and the computerized system. Besides manual system, a few existing software that can be purchased online and previous thesis are reviewed too. The features provided by them are compared with CMIS in this chapter.

A few technologies are reviewed in order to choose the best approach to implement the system. There are many development tools that are available in the market. Different development tool offers different approach. Each tool has its own strengths and weaknesses. So, this chapter intends to present some of the features offered by certain development tools and platforms. The development tools and platforms reviewed include operating systems, programming languages, and databases.

After the literature review was carried out, it is definitely resulted a more understanding of the system to be developed. Besides, it is hoped that the most convenient development tools and platform are chosen for the development phase in the near future.
3 Methodology and System Analysis

3.1 Introduction

Thoroughly planning is a must in a project for effective development in order to achieve the project's goals. System analysis is important to a newly develop system. System analysis is the phase where the study of the current system is done and including the definition of the user requirements for the new system.

3.2 Fact-finding Techniques

Fact-finding techniques refer to the methods of gathering information, requirements, and preferences concerning the system to be built. This technique is indeed needed in order to establish a complete understanding of the system. A few techniques have been used in this project for gathering useful and related data. It is also called information gathering or data collection.

- Internet
  Internet is one of the most important and complete information-gathering centers. It provides its users with a wide range of information and reference. Therefore, it becomes the main source for any ambiguities that are arisen in the development work. Information can be gathered through websites that are concerning the different platforms, development tools, database and etc.

- Research
  Research has been done on the previous thesis in order to get some general idea about how the project is carried out. The previous thesis that are reviewed are "Medical Information System" and "Sistem Pengurusan Maklumat Pesakit Klinik"
Utama”. It also helps to organize and analyze the requirements, benefits and limitations of the project to be developed.

- Interview and questionnaire
  In order to well suit the system with the real world environment, interview is one of the important portions to be carried out. By interviewing, actual information that is needed to build up a system can be gathered. Besides, further information can be obtained through the questionnaire. In addition to that, comments about the inefficiency of the manual and current system are recognized. The interview was conducted in Klinik Wong and Klinik Mediviron Sdn. Bhd. Suggestions for the new system are also provided through the interview.

- Review current manual system
  By studying the current system, a full understanding of the system is obtained. A review to the current system is important because it gives us the opportunity to study the efficiency and inefficiency of the current system. It is hoped that the review will assist in building a user-friendly system to increase the efficiency and effectiveness of the system and cover the users’ requirements.
3.3 Project Methodology

3.3.1 Prototyping

Prototyping is a system development methodology that uses "trial and error" approach for discovering how a system should operate. The greatest strength of prototyping is that the process helps to develop a close working relationship between the system developer and the users. This relationship assists build trust and acceptance for the new system. A second strength of the prototyping is that it is arguably the best systems development method for identifying how a system should operate when the system’s specifications are hard to define. Also, the cycle of the prototyping process proceeds rapidly [1]. Figure following shows how prototyping works.
3.3.2 Waterfall Model with Prototyping

The development strategy in this project is Waterfall Model with prototyping. In the development of the project, the Waterfall Model will serve as the base for the whole development because the steps of it is very similar to the generic steps of software development process that are applicable to all software engineering paradigms. It also provides a template into which methods for analysis, design, coding, testing, and maintenance can be placed. The waterfall model is used because it can easily identify the project’s milestones. Besides, the stages are easily separated from another. It defines clearly each stage of the development process. Furthermore, the simplicity of the
waterfall model can make it easy to explain to end users who are not familiar with the software development.

Prototyping is involved in the early stages of the development where there was a high degree of uncertainty in several areas in the user requirements. The emphasis of prototyping is on trying out and experimenting with ideas, elicit and experiment with user interface requirements and usability factors as well as providing, assumptions about requirements not on system completeness. With the integration of prototyping, it makes the requirement analysis, system design, and program design much more easier and accurate to be captured and done. Besides, it is not feasible for developers to journey through the entire Waterfall model to make enhancement.

![Figure 3-2: A graphical model of the Waterfall Model with Prototyping.](image-url)
The principal stages of the model map onto the fundamental development activities as followed:

- **System Requirements Definition**

In this phase, potential systems are identified, selected, and planned. The system is concluded with a complete set of requirements of the desired external behavior of the system to be developed.

- **System Analysis**

System analysis is learning about the problem to be solved. It is a study of problem domain to recommend improvements and specify the requirements for the system. It is also used to understand all the constraints on the solution. In this phase, many tasks or sub-phases are performed. It is a decomposition process where decomposing the problems into sub-problems with the goal of understanding the entire problem. After this stage, a thorough understanding is gained about the system to be developed. This includes determining the system requirements and etc. After the requirements are collected, information is organized using the data, and processes.

- **System Design**

In this phase, the proposed system is designed according to the details of the particular approach chosen. It establishes an overall system architecture. There are a few elements that must be designed during this stage. These include forms and reports, interfaces and dialogues, databases and files, processing and logic, and etc.
• Coding and Implementation

Many separate activities occur during the system implementation. It is focusing on the transformation of the system design into a working information system. These activities include software programming and system testing. Other activities include system conversion, documentation, user training, and support is focused on preparing for using the new information system.

Programming or coding is the process of transforming the system design into a working computer system. It is also concerning the transformation of the algorithms defined during the design stage into a computer understandable language. During this transformation, both processing and testing occur in parallel. A broad range of testing is performed before a system is completed. The testing will check the entire system behaves according to its specifications during design phase.

• Maintenance and Enhancement

After the system is delivered, it is essentially in the maintenance phase of the development cycle. Maintenance is the continued detection and repair of bugs after deployment whereas enhancement means additional of new capabilities. In this phase, maintenance requests are collected from the users. As with the initial development of the system, implemented changes are formally reviewed and tested before installation into operation systems. The system maintenance process parallels the process used to initially develop the information system.
### 3.4 System Analysis

The investigation, analysis, design, implementation, and evaluation of an information system, usually with the aim of computerizing some human activity. First, the problem to be solved must be accurately defined. The existing system is then investigated to understand how it works, using techniques such as flow charts and decision tables. Next, the results of the investigation are analyzed and used as the basis for the design of a new system, making optimum use of the available computer hardware, software, and staffing resources. If it is a new system to be developed, all the user requirements such as user interface, data entry screen, reports, security, and etc as well as the possible constraints need to be identified until the complete understanding of the system is gained.

### 3.5 Importance of System Analysis

System analysis decomposes the system into its smaller component pieces in order to study how well each component parts work and interacts to accomplish its purposes. System analysis is an important and essential phase in the software development life cycle. It is used to determine all the requirements before proceeding into subsequent phase [9].

The purposes of this analysis phase are:

- To survey how available system has been used and what it does.
- To acquire knowledge on how a patient information system works.
- Research on how this system can be developed using current and maybe newly emergence technologies.
Chapter 3 Methodology and System Analysis

- To understand the system data flows and processes.
- To identify the major and minor components that will include in the system.
- To identify the software and hardware requirements to develop and reside in the system.
- Analyze control features to develop a robust and reliable system.

3.6 Requirements Analysis

3.6.1 Functional Requirements

Functional requirements refer to the description of activities, functions, and services or, features a system must provide [5]. In these cases, the system should react to particular inputs and should behave in some particular situations. Sometimes, it is also stated that what system should not do. Furthermore, it is independent from the implementation of the solution.

Basically, there are four components recognized as the most important functional requirements for this project: Security Module, Doctor Module, Staff Module, and Pharmacist Module.
3.6.1.1 Security Module

This module consisting of several important sub-modules that provide the security functions to enable only the authorized users to log in to the system.

i. Login

This sub-module allows users to login to the system. To use this system, users have to input their username and password. The system will search and match the username and password in the database. Thus, only authorized users are allowed to login to the system.

ii. Logout

This sub-module allows users to logout from the system. After using this system, the users are required to logout from the system. This will surely increase the security of the system.

iii. Change password

This sub-module allows users to change their password from time to time. Users are required to enter their username and password before they can proceed to change the password.

iv. Add new user

This sub-module allows doctor to add new user to the system.

v. Delete existing user

This sub-module allows doctor to delete existing users who quits from his/her responsibilities.
3.6.1.2 Doctor Module

This module provides several sub-modules that will help to ease the job of the doctor. The doctor can view, and add treatment records for the patient.

i. View records
   Doctor can easily view the patients’ previous record from the computer screen. Only a unique name or registration number is needed to retrieve the record from the database.

ii. Add medical records
   After examine the patient, the doctor input the medical record, treatments, and the drugs prescription to the database. It is useful for easy reference in the future reference.

iii. Update medical records
    Doctor is the only person who will update the medical records for the patient. The doctor can update the medical records based on the patient’s current health status. This provides the doctor with the updated medical records and thus consults the patient appropriately.

iv. Search records
    The doctor can search the patients record through their registration number or their identity card number.

v. E-mail
    The doctor can email to the doctor in other clinic or hospital once he realizes that the patient needs further treatment.
vi. Print referral letters or Medical Certificates
In this sub module, doctor can print referral letter for the patient who needs further treatment as well as the medical certificates.

vii. Appointment
The doctor can make appointments for patients who need further treatments.

viii. Backup records
The doctor can backup the record of the patients in the other database.

ix. Manage staff data
The doctor can manage the staffs’ record and data easily. It helps to keep track the records easily.

3.6.1.3 Staff Module

i. Add record for new registration
Staff can make a new registration easily through the computer keyboard. Data for the new patient is then created and stored in the database.

ii. Update record
Only Staff and doctor can update the profiles for the patients. Data can be updated from time to time.

iii. Delete records
This sub module helps the staff to delete the patient’s record according to some situation or condition.
iv. Search records
The staff can search the record of a patient through his/her patient ID or IC number if he/she forgot to bring the patient ID card. Besides, the staff can search the patient’s record for updating purpose.

v. Print report
Staff can print the receipts for the patients. Besides, this module will assist the staff the summary of the daily, and monthly incomes.

vi. Financial
This sub module will help the clinic calculate the daily, monthly and yearly incomes. It also helps to calculate the expenses of the clinic.

vii. Appointment
This sub module will benefit the patient that needs a few treatments. It will assist the staff in making appointment for the patient for next treatment.

viii. Generating of graph
Graphs are generated for patients’ ratio and incomes analysis.

ix. Backup data
The staff can backup data for the patients’ profiles and other records.
3.6.1.4 Pharmacist Module

i. Drug inventory
This sub-module will help the pharmacist in the drug inventory stock. Drugs quantities are automatically deduced after the drug is given to the patients. Efforts to count the quantity are saved. Besides, a list will list out the drugs that are in critical balance or near its expiry date.

ii. Add new drugs
The pharmacist can add new drugs record to the database.

iii. Delete drugs’ record
The drugs’ record that is no longer in use can be deleted from the database.

iv. Search drugs record
The pharmacist can search the drugs easily from the database.

v. Edit drugs’ record
Drugs’ information can be updated or edited from time to time.

vi. View drugs’ record
This sub-module will list the description and other important information such as supplier, cost per unit of the drugs.

vii. Printing of drugs’ summary and drugs’ label.
The pharmacist can print the drugs’ label. Besides, drugs’ summary can be printed for easy reference.
Dispensation of medicine prescription
The pharmacist is able to dispense the medicine to the patient more accurately and reduce errors during dispensing of medicine.

Backup drugs' record
The pharmacist can backup the drugs’ record in other database.

3.6.2 Non-functional Requirements

Non-functional defines the description of other features, characteristic, and system constraints that define a satisfactory system [5].

- Reliability
The system should be reliable in performing its daily functions and operations. It shall not produce any fatal or costly failures when it is being used. Besides, it is expected to perform its intended functions accurately and precisely.

- Usability
The system should be easy to use and navigate. The complexity of the system shall be eliminated. The usability of the system will promise it will not limit and restrict the daily operations as well as the administration.

- Security
The system ought to be equipped with sufficient security. Each access has to be authenticated and validated by the system. This will help to protect of any leakage of confidential information.
• Manageability
The system should be developed in the sense of easy to manage. All the administration procedures must in simple mode. This will make the maintenance and enhancement simpler and not very time-consuming.

• Flexibility and scalability
The system should have posses the capability to take advantage over new technologies and resources. It means that the system can be adapted to meet changing requirements.

• User-friendliness
The graphical user interface uses pictures and icons as well as menus to send instructions back and forth from the user to the computer system. It is a way of presenting program control functions and output to user. It provides better visual meaning to the users. Meaningful icons encourage the users to use the system more confidently. Besides, it enables users to avoid inputting sometimes-arcanec commands into the computer and unintentionally mistakes. Nevertheless, confirmation messages will be displayed for non-trivial processes such as deletion and data updating.

• Robustness
The system that is consisting of different modules will be testing to ensure each module achieves its expected outcome and functions. After the modules testing, the modules will be then integrated and tested. Any errant that is discovered during the system testing will be solved immediately. This will ensure the robustness of the system to its expected level.
• Modularity and maintainability

System design and coding will be implemented using the modular approach. This approach decomposes the system into a hierarchy of modules such that the higher-level modules define the system in general whereas the lower level modules describe the system in more specific terms. This will make the system easy to understand, code, debug, and maintain.

• Legislation

All of the software including the platform and software used must be assured with a licensed copy. None of the pirated software is permission to be used.
3.7 Technologies Analysis Conclusion

After analysis on the strengths, advantages, constraints, and limitations of the various technologies – software and hardware, this system will be built using programming language Microsoft Visual Basic 6.0, DBMS Microsoft SQL Server 7.0, client-server architecture, platform Windows 2000 in client side and in server side.

For the development of the CMIS, Microsoft Visual Basic 6.0 is chosen for its ease to use, thus more focus on the designing and developing the functions of the system. Visual Basic integrated well with Windows based platform, and run faster than its competitive programming language – Java. System developed with Visual Basic has a Windows based graphical user interface, thus giving the users more familiar with functions available, less training, and user-friendly.

Backend system consists of a Database Management System (DBMS) installed at Server side. The DBMS chosen is Microsoft SQL Server 7. SQL Server is chosen comparing with Microsoft Access 2000 because SQL Server is more reliable; support a large number of concurrent users, good security features, and good database management, as well as support a Very Large Database (VLDB) that may be in terabytes of data.

Client-server architecture of network is chosen because it is more reliability, ensuring good security measures, learner to add additional clients, and easy to implemented. Client-server is more reliability than other network, like Internet, because client-server is normally using Local Area Network (LAN) to connect between them. LAN can guarantee safe and sound transportations of data without concerns about the data secrecy and integrity.
Windows platform is chosen for the client and server side. The reason for this choice is Windows platform is easier to use and many users already use Windows before, thus they need less training and can maintain the system well. Windows 2000 offers greater reliability, greater scalable, easier to manage, higher level of security, and etc. Furthermore, Windows 2000 is faster than any operating system released by Microsoft [15]. Besides, Windows platform designed to work perfectly with Visual Basic program and SQL Server.
3.8 Run-time environments

3.8.1 Server Hardware and Software Requirements

The following computer hardware and software configuration was found to be the most suitable to deploy the server environment.

<table>
<thead>
<tr>
<th>Computer Processor Unit</th>
<th>Processor not less than 350 MHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard Disk Space</td>
<td>10.2 GB</td>
</tr>
<tr>
<td>Random Access Memory</td>
<td>128 MB RAM</td>
</tr>
<tr>
<td>Additional Devices</td>
<td>CD-ROM Drive, Printer, UPS, Network Interface Card (NIC)</td>
</tr>
<tr>
<td>Operating System</td>
<td>Microsoft Windows 2000 Server</td>
</tr>
<tr>
<td>Database Management System</td>
<td>Microsoft SQL Server 7.0</td>
</tr>
</tbody>
</table>

*Table 3-1: Server hardware and software requirements.*

3.8.2 Client Hardware and Software Requirements

The following computer hardware and software configuration was found to be the most suitable to deploy the client environment.

<table>
<thead>
<tr>
<th>Computer Processor Unit</th>
<th>Processor not less than 300MHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard Disk Space</td>
<td>4.2 GB</td>
</tr>
<tr>
<td>Random Access Memory</td>
<td>64 MB RAM</td>
</tr>
<tr>
<td>Additional Devices</td>
<td>CD-ROM Drive, Printer, Network Interface Card (NIC)</td>
</tr>
<tr>
<td>Operating System</td>
<td>Microsoft Windows 2000 Professional</td>
</tr>
</tbody>
</table>

*Table 3-2: Client hardware and software requirements.*
3.9 Chapter Summary

In order to develop a system that is really fulfilled the working environment, a few techniques are used to gather information that is important to the system to be built. Techniques such as interview and questionnaire, Internet, research on previous thesis, and review current manual system were carried out to obtain the information and data that are crucial and useful to the system to be developed.

The methodology chosen to develop CMIS is Waterfall Model with prototyping. Waterfall model will serve as the base of the whole development. Whereas, prototyping involved in the early stages of the development where there was a high degree of uncertainty in several areas in the user requirements.

Requirements analysis was done in this chapter as well. The requirements analysis is divided into functional and non-functional requirements. Functional requirements are categorized into Security Module, Doctor Module, Staff Module, and Pharmacist Module. These will be the functions that this system provides. Whereas, non-functional defines the description of other features, characteristic, and system constraints that define a satisfactory system.

This chapter also concludes the technologies, tools and platform that will be using in the development phase. It also stated the run-time environment requirements in hardware and software for the server and client.
4 System Design

4.1 Introduction

System design is defined as those tasks that focus on the specification of a detailed computer-based solution, on the technical or implementation [5]. It is also called physical design. The purpose of system design is to determine how to construct the information system to best satisfy the documented requirements. Meanwhile, the goal of the system design is to design an information system that is effective, reliable, and maintainable. In general, the design processes begin with the output progresses to input, then data storage, and system processing. The design phases are focused on user interface design, data storage, and system structure (how data are linked).

4.2 Architectural design

In architectural design, large system is decomposed into sub-systems that provide almost all related set of services. This is the initial design of identifying sub-systems, establishing a framework for sub-system control and communication. Besides, the sub-systems that make up the whole system and their relationships are identified and documented. The following figures are:

- Context Diagram of CMIS.
- Structure Chart of CMIS.
- Zero Level DFD for Doctor Module.
- Zero Level DFD for Staff Module.
- Zero Level DFD for Pharmacist Module.
Figure 4-1: Context Diagram of CMIS.
Figure 4-2: Structure chart of CMIS.
Figure 4-3: Zero level DFD for Security Module.
Figure 4.4: Zero level DFD for Doctor Module.
Figure 4-5: Zero level DFD for Staff Module.
Chapter 4  System Design

Figure 4-6: Zero level DFD for Pharmacist Module.
4.3 Database Design

Database design is the process of translating logical data models into physical database schemas [5]. The design of the database is very important because it greatly affect the performance of data retrieval, updating, and query as well as in the run-time period of the system. Besides, a database should be reliable, adaptable, and scalable to new and unforeseen requirements and applications. Below are some of the database tables of CMIS. Symbol ** represents the primary key.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Data type</th>
<th>Size</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PatientID</strong></td>
<td>int</td>
<td>10</td>
<td>Unique number generated by SQL for patient created</td>
</tr>
<tr>
<td>Name</td>
<td>Char</td>
<td>50</td>
<td>Patient’s name</td>
</tr>
<tr>
<td>ICMNumber</td>
<td>Char</td>
<td>15</td>
<td>Patient’s identity card number</td>
</tr>
<tr>
<td>Address</td>
<td>Char</td>
<td>50</td>
<td>Patient’s address</td>
</tr>
<tr>
<td>PostCode</td>
<td>Char</td>
<td>6</td>
<td>Post code</td>
</tr>
<tr>
<td>City</td>
<td>Char</td>
<td>20</td>
<td>City</td>
</tr>
<tr>
<td>State</td>
<td>Char</td>
<td>20</td>
<td>State</td>
</tr>
<tr>
<td>Country</td>
<td>Char</td>
<td>20</td>
<td>Country</td>
</tr>
<tr>
<td>HomePhone</td>
<td>Char</td>
<td>15</td>
<td>Home telephone</td>
</tr>
<tr>
<td>MobilePhone</td>
<td>Char</td>
<td>15</td>
<td>Mobile phone</td>
</tr>
<tr>
<td>Race</td>
<td>Char</td>
<td>10</td>
<td>Patient’s race</td>
</tr>
<tr>
<td>Gender</td>
<td>Char</td>
<td>10</td>
<td>Gender</td>
</tr>
<tr>
<td>BloodType</td>
<td>Char</td>
<td>5</td>
<td>Patient’s blood type</td>
</tr>
<tr>
<td>MaritalStatus</td>
<td>Char</td>
<td>10</td>
<td>Patient’s marital status</td>
</tr>
<tr>
<td>Nationality</td>
<td>Char</td>
<td>20</td>
<td>Patient’s nationality</td>
</tr>
<tr>
<td>Occupation</td>
<td>Char</td>
<td>50</td>
<td>Patient’s occupation</td>
</tr>
<tr>
<td>PassportNo</td>
<td>Char</td>
<td>50</td>
<td>Patient’s passport number</td>
</tr>
</tbody>
</table>

Table 4-1: Database table of Patient’s Personal Information.
<table>
<thead>
<tr>
<th>Field name</th>
<th>Data type</th>
<th>Size</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DrugID</strong></td>
<td>Char</td>
<td>20</td>
<td>Unique drug’s ID</td>
</tr>
<tr>
<td>Description</td>
<td>Char</td>
<td>500</td>
<td>Description of the drug</td>
</tr>
<tr>
<td>Allergies</td>
<td>Char</td>
<td>500</td>
<td>Drug’s allergies</td>
</tr>
<tr>
<td>Precaution</td>
<td>Char</td>
<td>500</td>
<td>Precaution to use the drug</td>
</tr>
<tr>
<td>SupplierID</td>
<td>Char</td>
<td>50</td>
<td>The drug’s supplier</td>
</tr>
<tr>
<td>Quantity</td>
<td>Int</td>
<td>1000</td>
<td>Drug’s quantity</td>
</tr>
</tbody>
</table>

*Table 4-2: Database table of Drug’s details.*

<table>
<thead>
<tr>
<th>Field name</th>
<th>Data type</th>
<th>Size</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PatientID</strong></td>
<td>Int</td>
<td>10</td>
<td>Unique number generated by SQL for patient created</td>
</tr>
<tr>
<td>Disease</td>
<td>Char</td>
<td>50</td>
<td>Disease infected by the patient</td>
</tr>
<tr>
<td>Date</td>
<td>smalldatetime</td>
<td>4</td>
<td>Date the patient is infected by the disease</td>
</tr>
</tbody>
</table>

*Table 4-3: Database table of Patient’s Disease History.*

<table>
<thead>
<tr>
<th>Field name</th>
<th>Data type</th>
<th>Size</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PatientID</strong></td>
<td>Int</td>
<td>10</td>
<td>Unique number generated by SQL for patient created</td>
</tr>
<tr>
<td>Treatment</td>
<td>Char</td>
<td>50</td>
<td>Description of the treatment given to patient including name and quantity</td>
</tr>
</tbody>
</table>

*Table 4-4: Database table of Patient’s Treatment.*
<table>
<thead>
<tr>
<th>Field name</th>
<th>Data type</th>
<th>Size</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>Char</td>
<td>15</td>
<td>Name used to represent an identity of a user</td>
</tr>
<tr>
<td>Password</td>
<td>Char</td>
<td>8</td>
<td>Security code needed to login to CMIS</td>
</tr>
</tbody>
</table>

*Table 4-5: Database table of User Details.*

<table>
<thead>
<tr>
<th>Field name</th>
<th>Data type</th>
<th>Size</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PatientID</strong></td>
<td>int</td>
<td>10</td>
<td>Unique number generated by SQL for patient created</td>
</tr>
<tr>
<td>Date</td>
<td>smalldatetime</td>
<td>10</td>
<td>Appointment date</td>
</tr>
<tr>
<td>Treatment</td>
<td>Char</td>
<td>50</td>
<td>Description of the treatment needed</td>
</tr>
</tbody>
</table>

*Table 4-6: Database table of Appointments.*
4.4 User Interface Design

User interface design is concerned with the dialogue between a user and the computer. It is concerned with everything from starting the system or logging into the system to the eventually presentation of desired outputs and inputs [5]. User interface design is very important to offer a user-friendly, reliability, intuitive, minimize the need for users to memorize the process and events, and at the same time give a good impression to the users. Below are a few screenshots of user interface of CMIS system.

![Login Screen](image)

**Figure 4-7:** Login Screen.
Figure 4.8: Dispensation.
Clinic Management Information System

Version 1.0.0

Clinic Management Information System (CMIS) is a system that computerizes the clinic’s activities.

Warning: This computer program is protected by copyright law and international treaties. Unauthorized reproduction or distribution of this program, or any portion of it, may result in severe civil and criminal penalties, and will be prosecuted to the maximum extent possible under law.

Figure 4-9: About Screen.

List of Drugs

The list below shows the drugs that are expired or approaching their shelf life:

<table>
<thead>
<tr>
<th>BRAND_NAME</th>
<th>DRUG_NAME</th>
<th>SHELF LIFE</th>
<th>REMAINING</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acidine</td>
<td>Famotidine</td>
<td>29 Jan 02</td>
<td>30</td>
</tr>
<tr>
<td>Saizen</td>
<td>Somatropin</td>
<td>30 Jan 02</td>
<td>50</td>
</tr>
<tr>
<td>Nuelin</td>
<td>Theophylline</td>
<td>30 Jan 02</td>
<td>250</td>
</tr>
<tr>
<td>Upha Dextrophan</td>
<td>Dextromethorphan HBr</td>
<td>30 Jan 02</td>
<td>300</td>
</tr>
<tr>
<td>Tripta</td>
<td>Amtriplyline HCl</td>
<td>30 Jan 02</td>
<td>300</td>
</tr>
<tr>
<td>Sandostatin</td>
<td>Octreotide</td>
<td>30 Jan 02</td>
<td>125</td>
</tr>
<tr>
<td>Cupressin</td>
<td>Delapril HCl</td>
<td>30 Jan 02</td>
<td>500</td>
</tr>
<tr>
<td>Norcolut</td>
<td>Norethisterone</td>
<td>30 Jan 02</td>
<td>250</td>
</tr>
<tr>
<td>Beacolytic</td>
<td>Bronhexene HCl</td>
<td>30 Jan 02</td>
<td>100</td>
</tr>
<tr>
<td>Ancotil</td>
<td>Flucytosine</td>
<td>30 Jan 02</td>
<td>300</td>
</tr>
<tr>
<td>Kezoral</td>
<td>Ketoconazole</td>
<td>30 Jan 02</td>
<td>100</td>
</tr>
<tr>
<td>Moxpen</td>
<td>Amoxicillin</td>
<td>30 Jan 02</td>
<td>300</td>
</tr>
</tbody>
</table>

Show the drugs when their shelf life is [ ] days from now. Change

Figure 4-10: Expired Drug List.
4.5 Chapter Summary

System design is defined as those tasks that focus on the specification of a detailed computer-based solution, on the technical or implementation. There are three kinds of design defined in this chapter, which are Architectural design, Database design, and User interface design.

Architectural design partitions the system into subsystems and functions. It shows the overall system to be developed. It also provides the beginnings of an outline for drawing the data flow diagrams. Database design is the process of translating logical data models into physical database schemas. It is important because it can affect the overall performance of the system. Some of the tables are included in this chapter. User interface design is concerned with the dialogue between a user and the computer. Too complicated user interfaces will prevent users from using the system. Thus, the user interface should be user friendliness. A few screenshots of user interface of CMIS system are captured in this chapter.

Finally, it is hoped that the system design defined in this chapter will provide a full development guide in the development phase later.
5 System Implementation

5.1 Introduction

The process of assuring that the information system is operational and then allowing users to take over its operation is called system implementation. System implementation is further defined as the construction of the new system and the delivery of that system into production in a day-to-day operation. It involves coding step that translates a detailed design representation of software into a program language realization. System implementation implements the various components of the system based on the collected requirements, where the design is translated into a machine-readable form.

During implementation, all functionality planned in design phased is checked. It should be able to process the correct data and produce accurate information to end-users. Any problem or malfunction occurred is revised carefully and fixed accordingly.

5.2 System Development

The development environment is crucial for the completeness and successfulness of any computer system. Development environment plays a major role in determining the speed of developing the system. During development, the weaknesses will be noticed and improved; while the errors found will be removed.

Using suitable hardware and software will help to speed up system development. Thus, the hardware and software are carefully considered to facilitate the development of the Clinic Management Information System (CMIS). System development consists the
used of methodology chosen, forms coding, development tools, database connection. The details are illustrated as below:

5.2.1 Development Tools

5.2.1.1 Hardware Requirements

The following hardware specifications are required to develop CMIS:

- Pentium II 166 MHz CPU or above
- 128 MB RAM
- 10.2 GB Hard Disk
- 1.44 MB Floppy Disk
- Printer
- Other standard desktop PC components

5.2.1.2 Software Requirements

The following software specifications have been used to develop CMIS:

<table>
<thead>
<tr>
<th>Software</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows 2000 Professional Edition</td>
<td>Operating System</td>
</tr>
<tr>
<td>with Service Pack 2</td>
<td></td>
</tr>
<tr>
<td>Microsoft SQL Server 7.0</td>
<td>Database Server</td>
</tr>
<tr>
<td>Microsoft Visual Basic 6.0</td>
<td>Development tools</td>
</tr>
</tbody>
</table>
5.2.2 Methodology

This project is developed using the waterfall approach. The development of this project will consist of five stages, which are requirement, design, coding, testing and operation. The system is design using logical flow and it allows the estimation of the milestones. Each stage must be completed before proceed to the next stage to ensure that the system is built according to the requirements and specifications.

5.2.3 System Coding

System coding is a set of instruction written in order to enable the code to be executed and perform the required functionality. A good and well-managed program coding will enhance the readability of the whole program. In addition, it provides an easy understanding to the program flow especially for those programs with high degree of complexity.

5.2.3.1 Coding Approach

Coding is an iterative process whereby it is done until the programmer obtains the desired results. There are two types of coding approach; one is top-down and the other one is bottom-up. The bottom-up coding is based on coding some complete lower level modules and leaving the high level modules merely as skeletons that are used to call the lower modules, whereas the top-down approach is the reverse.

For this system, coding is done with the bottom-up approach. It involves implementing the high level and prioritized software modules that were further refined into functions and procedures. The advantages of this approach are: testing can be carried out on some of the functions as soon as it is completed, and critical functions can be coded first to test their efficiency. Besides, this technique had a great deal of impact in
programming where it has led to more reliable programs that are easier to debug and maintain.

5.2.3.2 Coding Style

Coding style and its convention rules are important attributes to the source code and determines the intelligibility of a program. Thus, the coding style used in developing CMIS follows the convention rules of a good programming style that involves the following:

i. Proper variables/fields naming that does not against the reverse name.

ii. Meaningful and understandable function and method declarations.

iii. Standard paragraph indentation for a neater look.

iv. Keep all complex or compound statement as simple as possible to avoid confusion.

5.2.4 System Coding Tool – Visual Basic 6.0

Visual Basic is used to develop this system because it provides a set of tools that make it easy to develop powerful Windows applications. The "Visual" part refers to the method used to create the graphical user interface (GUI). Rather than writing numerous lines of code to describe the appearance and location of interface elements, just simply add pre-built objects into place on the screen. The "Basic" part refers to the BASIC (Beginners All-Purpose Symbolic Instruction Code) language, a language used by more programmers than any other languages in the history of computing.

Visual Basic has evolved from the original BASIC language and now contains several hundred statements, functions, and keywords, many of which relate directly to the Windows GUI. Beginners can create useful applications by learning just a few of the
keywords, yet the power of the language allows professionals to accomplish anything that can be accomplished using any other Windows programming language.

Visual Basic also provides data access features to create databases, front-end applications, and scalable server-side components for most popular database formats, including Microsoft SQL Server and other enterprise-level databases [17].

5.2.5 Database Connection

The database for this project is created using Microsoft SQL Server 2000. The processes of creating database, creating and modifying tables and their relationship is made easy. Active X Data Object (ADO) is used to store and retrieve data from the database. This project uses the (Data Source Name) DSN-less connection strings to connect to Microsoft SQL Server.

\begin{verbatim}
Provider = SQLOLEDB; server = AMDK6-2; uid = cl; pwd = cl; database = CMIS
\end{verbatim}

All communication with a database takes place through an open connection. Before any information can be inserted into or retrieved form the database, a connection with the database must be established. The ADO connection object serves the purpose. For example:

```csharp
adcConnection.ConnectionString = "Provider=SQLOLEDB;
server=AMDK6-2; uid=cl; pwd = cl; database = CMIS"
adcConnection.ConnectionTimeout = 0
adcConnection.Open
```
5.3 Summary

This chapter describes the implementation of the system being developed. It begins with the introduction to the system implementation. System implementation implements the various components of the system based on the collected requirements, where the design is translated into a machine-readable form.

Then, the chapter describes the development environment of the system. The system development includes hardware and software requirements, methodology chosen, forms coding, development tools, and database connection. A sample code is included to show the coding environment.

System testing will be discussed in the next chapter.
6 System Testing

6.1 Introduction

Testing is the process of determining whether a system performs its desired processing. It is an integral component of the software process and an activity that must be carried out throughout the life cycle. Although testing is tedious, it is an essential and critical element of system quality assurance and represents the ultimate review of specifications design and code generation.

Due to the difficulty of detecting errors and then locating and correcting them once a system is in operation, CMIS was tested in several stages. System testing is required to ensure the system runs according to its specifications, reliable, and in line with the users’ requirements and expectations.

6.2 Objective of Testing

The reasons and objectives for performing extensive tests during the design and development of the system are as followed:

• Achieve high quality assurance such as completeness, accuracy, reliability and maintainability of the software program and its documentation.
• Ensure that the system can perform its functions as expected.
• Reduce cost in maintaining the system.
• A method for detection and removal of errors.
6.3 Testing Technique

The component of a system will be allowed to manipulate the data, and the output will be observed. Thus, a wide range of inputs and conditions are chosen in order to test that particular component. A test point/test case is a particular choice of input data to be used in testing program. Different test cases are needed on different types of testing strategies. There are two type of testing technique applied in the testing stage of the system: white box testing and black box testing.

6.3.1 White Box testing

White box testing is a testing case design method that uses the control structure of the procedural design to derive test cases. By using white box testing methods, the test cases with the following characteristics can be derived [20]:

- Exercise all logical decision on their true or false side.
- Exercise all loops at their boundaries and within their operational bounds.
- Exercise internal data structure to ensure their validity.
- Guarantee that all independent paths within a module have been exercised at least once.

6.3.2 Black Box Testing

Black box testing focuses on the functionality requirements of the system. It enables the developer to derive sets of inputs conditions that will fully exercise all functional requirements fro an application. Black box testing was not used as an alternative to white box testing technique rather this technique is used as a complementary approach that is likely to uncover a different class of errors. Black box testing attempts to find errors in the following categories.
• Incorrect or missing functions
• Interface errors
• Errors in data structures or external data access
• Performance error
• Initialization and termination errors

It also tests the functionality of the system in an ad hoc basis without knowing the logic structure of the code. Input is provided and output is verified manually to check for accuracy [20].

6.4 Testing Strategy

A strategy used to test this system is actually a series of steps that are implemented sequentially. After a program is completely coded, it will be tested under unit testing. Module testing will start when all the programs under a particular module have been completely coded and tested under unit testing. The integration testing is to recover errors associated with interfacing when integrating all the modules.

6.4.1 Unit Testing

Unit testing focuses on verification effort on the smallest component of the system design. Each component is treated as a standalone entity and tested individually to ensure that they operate correctly. The unit test is usually white-box oriented and the step can be conducted in parallel for multiple components.

The test that occurs as part of unit tests is illustrated schematically in Figure 6.1. The module interface is tested to ensure that information properly flows into and out of the program unit under test. The local data structure is examined to ensure that data
stored temporarily maintains its integrity during all steps in an algorithm's execution. Boundary conditions are tested to ensure that the module operate properly at boundaries established to limit or restrict processing. All independent paths (basis path) through the control structure are exercised to ensure that all statements in a module have been executed at least once. Finally, all error-handling paths are tested.

![Diagram](image)

*Figure 6-1: Unit Testing.*
6.4.1.1 Unit Testing Example

Each table in the database has at least associated with two trigger programs, which are Record Adding and Record Deleting. Unit testing was carried out on each trigger program once it was completed. Table below shows the test case for unit testing on the Drug Record Adding and Deleting trigger program.

<table>
<thead>
<tr>
<th>Step</th>
<th>Test Procedure</th>
<th>Expected Output</th>
<th>Test Result Analyzing</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Add a new drug record to the system</td>
<td>The record is inserted permanently in the database.</td>
<td>The record is inserted successfully.</td>
</tr>
<tr>
<td>2</td>
<td>Enter the drug’s name and search for that record.</td>
<td>The information for that drug is selected and shown to the user.</td>
<td>The drug’s record is shown successfully and correctly.</td>
</tr>
<tr>
<td>3</td>
<td>Press Delete button to remove the selected record from the database.</td>
<td>The record is deleted permanently from the table.</td>
<td>The record is removed permanently from the table.</td>
</tr>
</tbody>
</table>

*Table 6-1: Unit Testing Example*

6.4.2 Control Objects Testing

Command buttons are clicked to test their functionality and text boxes are tested with different data types and also null value to make sure invalid data will not cause any fault.
6.4.3 Different Data Type Testing

Different data types like numbers, characters or date is used to test certain function because some control objects will only accept certain data type, invalid data type can be traced by the system without causing any error.

6.4.4 Module Testing

Module testing is to test the form of the system. All the programs under a sub module are grouped into one form and all the related forms are grouped into a module. This testing will make sure all the forms are link to the right location.
### 6.4.4.1 Module Testing Example

After all of the triggers program for certain table were developed, module testing is carried out to ensure that the module is functioning as expected. Table below shows the test case for module testing on the triggers program for table TBL_PATIENT.

<table>
<thead>
<tr>
<th>Step</th>
<th>Test Procedure</th>
<th>Expected Output</th>
<th>Test Result Analyzing</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Click Login button to logon to CMIS.</td>
<td>CMIS Main Page is shown.</td>
<td>CMIS Main Page shown successfully.</td>
</tr>
<tr>
<td>2</td>
<td>Click New Patient to add a new record for the patient.</td>
<td>New Registration form is shown.</td>
<td>New Registration form shown successfully.</td>
</tr>
<tr>
<td>3</td>
<td>Fill all the required fields and click Register button to create the record.</td>
<td>The record is created and inserted in the database.</td>
<td>The record is created and inserted successfully in the database.</td>
</tr>
<tr>
<td>4</td>
<td>Click Search Patient button to display the record inserted.</td>
<td>The correspondence record in the TBL_PATIENT is selected and shown.</td>
<td>The correct record is shown.</td>
</tr>
</tbody>
</table>

*Table 6-2: Module Testing Example*
6.4.5 Integration Testing

Integration testing is a systematic technique for constructing the program structure while at the same time conducting tests to uncover errors associated with interfacing. Testing a specific feature together with other newly developed feature is known as integration testing. In other words, when the individual components are working correctly and meet the objectives, these components are combined into a working system.

In this project, a bottom-up approach has been used. Bottom-up integration testing begins construction and testing with modules at the lowest levels of the system and then moving upward to the modules at the higher levels of the system. Regression testing is the re-execution of some subset of tests that already been conducted to ensure that changes have not propagated unintended side effects. It is the activity that helps to ensure that changes (due to testing or for other reason) do not introduce unintended behavior or additional errors.

At the culmination of integration testing, this project is completely assembled as a package, interfaces and linking errors have been uncovered and corrected.

6.4.6 System Testing

System testing is a series of different tests designed to fully exercise the software system to uncover its limitations and measure its capabilities. The objective is to test an integrated system and verify that it meets specified requirements. Although each test in this project has a different, all work to verify that system elements have been properly integrated and perform allocated functions.
6.5 Summary

This chapter is all about testing. These testing include unit testing, module testing, integration testing, system testing, and etc.

Clinic Management Information System has been tested and debugged effectively to achieve the objectives of the system. Nevertheless, there is no foolproof testing that will ensure that programs are free of errors. The best approach would be to use a combination of testing method – black box and white box testing together with inspection.

According to Roger S. Pressman, he mentioned that “Testing cannot show the absence of defects, it can only show that system defects are present.” It is important to keep this in mind while conducting the software testing. [19]

Through all the testing phases, it is easier to ensure the system’s qualities and strengths. Debugging and fixing of the program can be done. The limitations of the system’s functionalities can be found and improved.

As a conclusion, testing phase is a very important phase in the System Development Life Cycle (SDLC), and it must be done repeatedly and carefully to assure good software quality.
7 System Evaluation

7.1 Introduction

In the process of developing a system, various problems have been identified which some have been solved and some of them are yet to be discovered and overcome. These problems were solved through research and studies in fields such as the Internet, Online Books, journals and reference books. Besides, a lot of system analysis has been done on technological and programming concepts to grasp the concept of Internet programming.

After all the designing and developing as well as implementing of CMIS, the end product of the project is brought up for evaluation. Clinic Management Information System was evaluated to identify the strengths and the limitations of the system. Besides, proposals and recommendations are made for the future enhancements of the system.

7.2 Problems Encountered and Solutions

7.2.1 Difficulty in Choosing a Suitable Development Tools

There are too many software tools that are available for developing CMIS as stated in the earlier chapters. It is difficult to choose the most suitable development tools from a wide variety of choices. Choosing a suitable technology and tools was a critical process as all tools possesses their own strengths and weaknesses. Besides, the availability of a technology, hardware and supporting software to support, its learning curve, compatibility with the existence operating system and technologies are also the major consideration.
In order to solve the problem, seeking advices and views from project supervisor, course-mates and even seniors engaging in similar project were carried out. Furthermore, A great deal of reading and research from many sources, like books and Internet regarding the problems helped to solve the problem, and choose the suitable tools were done before any decision was made.

7.2.2 Lack of Knowledge in Visual Basic 6.0

Since there was no prior knowledge of programming in Visual Basic 6.0, there was an uncertainty on how to organize the codes. These new programming languages and concepts were never taught before and to implement such as application requires a fair grasp of the languages. These programming approaches seem to be totally different from the traditional programming languages.

Although it really cause a lot of time to learn the new technology, but choosing to program in Visual Basic 6.0 proved to be a wise move. Most of the problems faced were manageable through browsing the Internet for related materials and referring to the reference books available in the market. Discussion with friends especially seniors using the same technology was a great help. A more efficient method was through trail and error during the coding phase.
7.2.3 Difficulty in Gathering Information

Gathering information is one of the most important phases of the project. Problems are arising when dealing with the requirements, as most of the clinics and doctors reluctant to disclose the information as required for the project. This has made useful data gathering techniques such as interviewing and observation difficult.

Therefore, in order to gather the needed information, other method of acquisition information required, such as informal interview with the doctors, research papers, Internet, and books are done.

7.2.4 Failure in Controlling Date Display Format

The common date format used in Malaysia is according to the United Kingdom format that is DD/MM/YYYY. However, implementing this format in MS SQL generates errors in the date we stored in database. The format that the MS SQL supports is the United States format as in MM/DD/YYYY. The incorrect date will be stored instead of the actual date if the date is stored in DD/MM/YYYY format.

To overcome this problem, all the date displayed and manipulated in CMIS is in MM/DD/YYYY format.

7.2.5 Difficulties in Defining The Flow Logic of the System

The system is only based on the information gathered from interviews with the doctors; as a result, the flow logic of the system is very hard to define. The system is only following the flow logic based on my understanding of the requirements and the important of ease of use.
7.3 System Strengths

• Simple, user-friendly and easy to use interface
The design of the interface of the system is based on graphical user interface (GUI). It is designed to be as user-friendly as the system can with the available technologies in market. Therefore, the system is relatively easy to learn and use. Command button, text box and other control objects are used to allow the user to execute command with ease. An action is just a click away and the user just needs minimal knowledge of mouse and keyboard to use this system.

• Display process and error messages
There are a lot of processes between the system and its database, therefore, it is important to inform the user what the system has done when clicking on any command button. Messages like "New Patient Registered!" or "Invalid password!" will be displayed to inform the user. Without these messages, user might think that the system is faulty if no results are returned when a command is executed. In addition, user also knows that record is inserted into the database successfully. When a process is unsuccessfully done, error message will be alerted. This system tries to decrease the total number of errors occurred.

• Good Security Features
Different level of users is created for different level of permissions on the system. The user needs to have the right password and login name to grant access to the system. Besides, all the passwords are encrypted with special algorithm to ensure system safe.

• Data validation
Data validation is done prior to insert record into the database. All the fields in the form will be checked for null value or invalid data type. With this feature, error
when inserting record into the database will not occur. Error message will also be prompted to the user if important field is not filled.

- **Accuracy and efficiency**
  Using CMIS, the doctor, the staff as well as the pharmacy will definitely practice less-paper environment. It is because all the information is stored in the database and can be easily retrieved from the database. This situation causes the advantage to eliminate pen and paper and even the writing errors. The information retrieved is accurate and correct. Besides, the system provides fast response to record searching and displaying.

- **Backup data**
  The information for patient or a drug is important to a clinic. Thus, CMIS provides backup data for these records. Even if the current database is corrupted, the doctor still can restore the database from the backup database. This will minimize the risk of losing all the patients’ medical histories.

- **Auto Drug Deduction**
  After the drugs are dispensed to the patient, the system will automatically deduct the amount dispensed. The pharmacy does not need to count the quantity of the drug one-by-one. This saves a lot of time on count on the balance of a particular drug.

- **Display low balance drugs and expired drugs**
  CMIS provides a feature of showing all the drugs that are in critical remaining quantity. Besides, it also lists out all the drugs that are approaching its shelf life or already expired. This will help the clinic to have an easy reference to the drugs that need to be reordered or not to use.
7.4 System Constraints

Due to time and knowledge limitation, there are a few system constraints shown at below. This include

• **Same Hard Drive Database Backup**
  For current CMIS, the backup database is stored in the same hard drive. This is unrealistic because if the hard drive corrupted, both the database and backup database will be damaged. Thus, losing all the important information and data.

• **No Report Generation**
  In CMIS, only the Medical Certificate, Referral Letter, Drug Summary, and Official Receipt will be generated and be printed out. No other type of reports and summaries are generated.

• **No Lab Test and Radiology Test Management**
  No lab test and radiology test keep tracking and management in current CMIS. All the lab test and radiology test have to be stored manually.

• **No Drug and Inventory Order**
  No drug and inventory order found in this current CMIS. The staff has to practice traditional method to order or purchase drugs and other equipments.

• **Dependent on Computer System and Electricity Power**
  The system is relied heavily on the computer system and electricity power. That means once one or both of these powers fail, the system will definitely down and not functioning. This will certainly affect the clinic’s daily activities and operations. Besides, if the system is down caused by virus infection, this situation will cause the system cannot operate.
7.5 Future Enhancements

System development is a dynamic process and changes must be expected. Due to the limited resources that I have, especially time, this has caused me to miss or overlook certain aspects of the system. However, after the development system has been completed and valuable advices and suggestions from my project supervisor, Puan Ainon and project moderator, Dr Ow, I have identified certain important aspects that I can add on for future enhancement. The additional features that can be implementing in future are as followed:

- **Backup Database**
  Although backup database is available in current CMIS, the backup database is stored in the same hard disk in the computer. This is risky if the hard disk corrupts. It can damage both the database and the backup database and thus, makes the restoration impossible. Therefore, there is a need to backup the database in other backup devices such as tape, diskette, CDROM, and etc.

- **Report Generation**
  In current CMIS, only the Medical Certificate, Official Receipt, Drug Summary, and Referral Letter are generated. This is certainly not enough for the clinic. Thus, in the future, more reports should be generated. These reports might include Daily and Monthly Financial Summary, Drugs Inventory Summary, Patient’s Medical Report, and etc.

- **Data Analysis**
  Data that are collected in the clinic can be analyzed for certain purpose or doing for some analysis. The result of the analysis can be plotted in graph for easy reference of the doctor and staff. The data that are suitable for analysis might include Patient Visited, Male and Female Ratio, Incomes and Expenses, Most
Commonly Disease Infected, and etc. Thus, in future enhancement, **CMIS will** include Analysis Module.

- **Lab Test and Radiology Test Managing**
  In current CMIS, no management on both the lab test and radiology test. In future enhancement, there should be a feature to keep tracking the lab test and radiology test that a particular patient undergone. This should give the system more capabilities in doing its daily activities.

- **Drug and Inventory Order**
  The drug and inventory order will be included in future enhancement to provide easy drug and inventory order from their suppliers.

### 7.6 Knowledge and Experience Gained

Towards the accomplishment of the Clinic Management Information System, from the beginning to the end of the development and final documentation, a number of problems and difficulties are encountered. However, the solutions to these problems and difficulties have brought numerous valuable knowledge and experience. The benefits and knowledge gained are as followed:

- **The importance of all phases in SDLC**
  System analysis is an important phase in the System Development Life Cycle (SDLC). This phase is capturing user requirements and the goal of the system. If this phase is wrong defined, it will cause faulty to the system development and later progress. With a complete and thorough system analysis, the system that is developed will fulfill all the requirements and achieve its goal.
System testing is also an important and critical phase in SDLC. There is no application that is free of error in this world. However, with the procedures in the system-testing phase, errors and faults in the system can be minimized. The functionality of each module or form can also be tested and confirmed that it meets the user requirements.

**Development tools knowledge**

This project is developed using Microsoft Visual Basic 6.0 (VB6) and Microsoft SQL Server 2000. VB6 is a very powerful development tool for developing Windows environment information system. It is easy to use and provides graphical user interface. Microsoft SQL Server 2000 is used as the database for this system; it is a database management system that is suitable for storing records which data are not very large.
7.7 Summary

Evaluation of a system is indeed needed to ensure its objectives and intended functions have been achieved. This chapter covers all the aspects of the evaluating application software.

The successful development of the system at the present is the first step towards the future expansion of the system. The problem encountered and experience gained during the development phases should be helpful in future endeavors.

Besides, this chapter also summarizes the system strengths, system constraints, and future enhancements that can be added. The future enhancements will equip the system towards more capabilities of doing its daily operations and activities.

Lastly, the knowledge and experience gained are also discussed in the last part of the chapter.
8 Conclusion

Clinic Management Information System (CMIS) is a management information system to manage as well as to computerize the clinic’s activities. This system will manage all the data from the patient’s records to the medical records. And these records are stored in database with easy references. Besides, it also provides some analysis for the users of the system. However, the system will become more complete and capable of performing more tasks when the enhancements and the new features are added on in the near future.

In the process of developing CMIS, invaluable insight was gained into complexities and intricacies of programming. The application of Software Engineering principles, fundamentals, and additional knowledge in programming languages, skills in database management system and others all added up to contribute to the success of developing this system. Adhere to a development schedule is crucial in determining that a system will be completed in time. The experience gathered in this project will definitely provide me a solid foundation in the system development in the future.

With target goals and objectives in mind even before the development takes place, makes the development process more systematic. Sometimes, conflicts in real world situation and programming tools capabilities make the programming difficult. However, as an overall review, this project has achieved and fulfilled the objectives and requirements determined during the analysis phase with mirror adjustments and enhancements.
REFERENCES


Retrieved July 25, 2001 from the World Wide Web:
http://www.obmsoftware.com/ocm%20text.htm

Retrieved July 25, 2001 from the World Wide Web:
http://www.medicomsoft.com/product/#func

Retrieved July 22, 2001 from the World Wide Web:


[7] Linux Online. What is Linux?
Retrieved June 29, 2001 from the World Wide Web:
http://www.linux.org

Retrieved July 23, 2001 from the World Wide Web:
http://www.xrefer.com

http://www.microsoft.com/sql/evaluation/default.asp

Retrieved July 11, 2001 from World Wide Web:
http://databases.about.com/ab-databases/myforums/msg.html


Retrieved July 19, 2001 from the World Wide Web:
http://www2.bc.edu/~gallaugh

Retrieved July 19, 2001 from the World Wide Web:
http://www.officewizard.com/default.htm

[15] Global Care Solutions
Retrieved July 23, 2001 from the World Wide Web:
http://www.hospital2000.com

Retrieved July 20, 2001 from the World Wide Web:
http://www.cplusplus.com


1. What is the current system running in your clinic?
   i. Manually
   ii. Computer-based
   iii. Web-based
   iv. Others (Please specify) 

2. What are the advantages and limitations of the current system in your clinic?

3. What are the procedures of the registration in your clinic?
   E.g.: Patient arrived → register → waiting for consultation ...

4. Is the following information enough for a new registration? Please tick (√) for the relevant data that is needed.
   ( ) Identification data (e.g. name, DOB, gender, race and etc).
   ( ) Demographic data (e.g. address, occupation, marital status, contact number,...)
   ( ) Allergies
   ( ) Family disease

   Please specify the data if the above data are not enough for registration.

5. Do the report generated for the patient? If YES, what are the important data that is needed in a patient medical report?
6. Who is allowed to update the patients’ profiles and medical records?
   ( ) Patient
   ( ) Administration Staff
   ( ) Doctor
   ( ) Others (Please specify)

7. Will the current system delete the patient’s profiles and medical records? If YES, in what condition or situation?

8. If a new system is being developed to computerize the administration of the clinic, what are the features or functions you would like to add in, that is not in the current system?

9. Are there any reports that are generated for the management?
Summary from the interviews:

1. Most of the clinics are still running manual system in their clinic. These include registration, dispensation of drugs, and etc.

2. Data that is needed in the registration includes identification data, demographic data, and allergies.

3. For the company patient, approval form, authorized letter that is specified by the company is needed. Some patients need to show their company identity card in some occasions.

4. No report is generated for the patient.

5. Administration staff is allowed to update the patient’s profiles only. Whereas the medical records are updated by the doctor. The medical records are kept confidential.

6. There are cases where the patient’s record is deleted. If the patient doesn’t come to the clinic for consultation in certain period, his/her record is deleted. Besides, for the patient who passed away, the record is removed also.

7. The problems facing by the clinic include:
   
i. Files may be misplaced or lost.
   ii. No system to keep tracks the drugs details.
   iii. Space is wasted to store the files.
8. Suggestions from the interviewees:

i. A user-friendly system because some of the doctors and nurses do not know how to use PC.

ii. The system should provide financial function.

iii. A system to keep tracks the drugs’ record.

iv. A system that is faster than the manual system.

v. A system that can link up the computers in the clinic.
USER MANUAL

WARNING

USER MANUAL VERSION 1.0.0 IS CLASSIFIED AS PRIVATE AND CONFIDENTIAL.
UNAUTHORIZED EXPOSED, COPIED, DISTRIBUTED OR ANY FORM OF UNAUTHORIZED
ACTIONS PERFORMED ON THIS MANUAL, OR ANY PORTION OF IT, MAY RESULT IN
SEVERE CIVIL AND CRIMINAL PENALTIES, AND WILL BE PROSECUTED TO THE
MAXIMUM EXTENT POSSIBLE UNDER LAW.

This user manual is specially distributed to all system users, and IT support staffs for
technical support.

Over time, due to amendments or upgrades to the features, and design of CMIS, caused
by software compatibility, facilities availability, additional user requirements, and
unpredictable situations, all information in this manual is subject to change without prior
notice. Changes will be documented in the following versions, and distributed to who
may be concern, as soon as possible. These additional documents will either consists of
(i) a full replacement of the document, or (ii) a partial update with each new page or
replacement pages to be inserted throughout the whole document.

Documented by: WONG CHOONG LEONG

Started on: 26 November, 2001

Ended on: 31 January, 2001
1.0 Hardware and Software Requirements

The hardware and software requirements for CMIS are as followed:

1.1 Hardware Requirements
The hardware specifications are:
- At least 450MHz processor
- 64MB RAM memory or more (recommend 128MB)
- 2GB of free hard disk space or more (depending to the size of data)
- Other support peripheral devices such as printer and etc.

1.2 Software Requirements
The software specifications are:
- Operating system platform - Windows 2000 Professional
- Database Management System – Microsoft SQL Server 7.0
2.0 Installation and Configuration

2.1 About Setup File
Setup file will be named Setup.exe located in the media (diskettes, or CD) provided by authorized sources. Any destructions to the files in the setup folder, or lost of files, the entire setup folder need to be replaced with the new set of setup files. Contact CMIS’s Developer for further technical supports.

2.2 How to Setup
Double click on the Setup.exe and follow the instructions in the setup wizard.

2.3 Database and Connection Configuration
Create a database with any name (recommend database name: CMIS) with size of initial 100MB, and size of log of initial 10MB in the Microsoft SQL 7’s format. Restore the empty database structure into the database.

Create a backup device with a name of bckCMIS pointing to any location, but recommend not at the same drive or disk as the original location of data files, in order to avoid problems, like hard disk failure, virus infections, an natural disasters.
3.0 User guide

3.1 Introduction

There are three types of users who involve in CMIS. The users are consisted of Doctor, Staff, and Pharmacist. Different kinds of responsibilities are included for certain types of user. The Doctor has the full privileges over the other users of CMIS. He/she can perform all of the functions and tasks that are included in CMIS, such as Add New User, Delete Existing Users, Add Medical Records, and etc. Whereas, the Staff can only manage patients’ profiles, transaction charge, and etc. Pharmacist can deal with the drugs’ affairs compared to Doctor and Staff.

3.2 Guide Using CMIS

This user guide is written based on the functions that are available in CMIS.

Notes:
1) The date in CMIS is formatted in MM/DD/YYYY.
2) Any severe problems encountered are required to report to the CMIS’s developer.
3.2.1 Add Appointment

The staff can add an appointment for a patient who needs further treatment. To add a new appointment, Click Administration ➔ Make Appointment. The window displayed is as followed.

![Appointment Making Window](image)

**Figure 1: Add Appointment**

The staff can search the patient’s profiles and add the appointment for the patient by choosing the date and time for that particular patient. The staff can also check the appointment list on a specific day by clicking the View Appointment List. The description is optional. Click Add Appointment after the date and time is chosen.
2.2 Add New User

Only Doctor’s level can add a new user to the system. To add a new user, click
File \( \rightarrow \) New \( \rightarrow \) User. The window displayed is as followed (Figure 2).

![Add New User](image)

Enter the basic information for the new user.

Username: ______________________

Full name: ______________________

Password: ______________________

To continue, click Next.

![Next & Cancel Buttons](image)

Figure 2: Add New User

The Next button is enabled after the Username field is filled. The Full name field
is optional. The temporary password provided for the new user is password. The
new user of the system has to change his/her password when he/she logsins later. If
the username is in use for other user, the system will prompt that the username is
in used and another username needs to be entered. Then, click Next button to
proceed the add new user action. Choose an access level that the system should
grant for this user. If there is a need to change the username or full name, click
Back. Click Cancel to cancel the action and click Finish to complete add new
user.
What level of access do you want to grant this user?

- Doctor
- Staff
- Pharmacist

< Back  Finish  Cancel

Figure 3: User Access Level

3.2.3 Appointment List

Please specify a date to view the Appointment List

- Friday, January 01, 2002

The appointments on the date specify are:

Figure 4: Appointment List
The doctor can view the appointment on a particular date. To view the appointments that have been made, click View → Appointment or using shortcut key CTRL+A or icon in the Main Page. The Appointment List is displayed as in Figure 4. An appointment can be cancelled by highlighting the appointment and click Delete Appointment. Click OK to dismiss the Appointment List.

4.4 Backup and Restore data
All the records in the database can be backup and restore. The records include patient’s profiles, staff profiles, medical histories, drug’s details and etc. To backup the record, click File → Backup or shortcut key CTRL+B. The backup window is displayed in Figure 5. Select the backup database option and click Backup Now. Or select Restore Database and click Restore Now. The backup database is stored in Backup Device in SQL Server. An acknowledge message will pop up when the backup and restore process complete.

Figure 5: Backup and Restore
2.5 Change password

Every user is required to login to the system. Users are advised to change their password from time to time for security purpose. By clicking the *Edit → Change Password*, a new window entitled Change Password is displayed as in Figure 6. The username is automatically loaded, and the user needs to enter his/her old password together with a new password to proceed with the change password operation. If the old password is detected incorrect, a message “Incorrect Password” pops-up. Whereas if the password does not match in both New Password and Confirm New Password field, user needs to enter both fields with the same new password. To cancel the action, click *Cancel*.

![Change Password Window](image)

Figure 6: Change Password
6 Daily Logs

The user who has logon to the system is kept track. Once a user is logon, the logon time is recorded for that user and the logout time for the user is recorded too when the user logoff or exit CMIS. To view the daily logs, click View → Daily Logs. The screen for the Daily Logs is displayed in Figure 7. The logon records can be deleting by pressing the Delete All button. To delete all records on a specify date; select a date and press Delete All button. The deletion also CANNOT be undoing. Click Close to dismiss the window.

![Daily Logs Screen](Image)

Figure 7: Daily Logs
2.7 Delete Existing User

Only the doctor has the authority to delete an existing user of CMIS. To delete an existing user, click Edit  →  Delete Existing User. A new window entitled Delete Existing User will be displayed as in Figure 8. Click on the username of the users that need to be removed. The selected name will be highlighted. Besides deleting an existing user, password can also be set for the user of the system who has forgotten his/her password. To set a password, click the user’s username, and then click the Set Password button. Enter new password in both New Password and Confirm New Password text. Click OK button to complete change password action and return to Delete Existing User page. Click button OK to return to the Main Page.

![Delete Existing User](image)

Figure 8: Delete Existing User
2.8 Dispensation

After the consultation, the patient will wait for the medicine from the pharmacist. To prepare the medicine, the pharmacist will first get the prescription from the system. To view the prescription for a particular patient, click Prescription → Dispensation or click the icon in the Main Page or using shortcut key CTRL+D. Enter the patient ID or IC No to get the prescription. If the prescription is not found, an error message is displayed telling the pharmacist that the prescription is not found. If the doctor doesn’t save the prescription, the mentioned situation will be encountered. By clicking the Dispense button or double click the drug’s name, the drug will be automatically deducted from the stock.

![Dispensation Diagram](image)

Figure 9: Dispensation
2.9 Drug Details

To view the drug's details for a particular drug, click Prescription → Drug → Details. The procedure is same as to manage the Staff Details (refer Staff Details or Patient Profiles for details).

2.10 Drug List

The drug list gives the pharmacist a fast reference of the drugs in the clinic. The drug's list can be sorted by Name, Vendor, or Quantity. Besides, the drug can be removed by clicking the Delete button. The drug's List is shown in Figure 10.

![Drugs' List](image)

Figure 10: Drug List
11 Expired Drug List

The expired drug list will list out all the drugs that are expired or approaching its shelf life. The pharmacist can determine how many days before the drug is expired should be listed out. And the expired drugs will be listed out automatically. Figure 11 shows the Expired Drug List.

<table>
<thead>
<tr>
<th>BRAND NAME</th>
<th>DRUG NAME</th>
<th>SHELF LIFE</th>
<th>REMAINING</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acidine</td>
<td>Famotidine</td>
<td>29 Jan '02</td>
<td>30</td>
</tr>
<tr>
<td>Saizen</td>
<td>Somatropin</td>
<td>30 Jan '02</td>
<td>50</td>
</tr>
<tr>
<td>Nuelin</td>
<td>Theophylline</td>
<td>30 Jan '02</td>
<td>250</td>
</tr>
<tr>
<td>Upda Dextrophan</td>
<td>Dextromethorphan HB</td>
<td>30 Jan '02</td>
<td>300</td>
</tr>
<tr>
<td>Tripta</td>
<td>Amitriptyline HCl</td>
<td>30 Jan '02</td>
<td>300</td>
</tr>
<tr>
<td>Sandostatin</td>
<td>Octreotide</td>
<td>30 Jan '02</td>
<td>125</td>
</tr>
<tr>
<td>Cupressin</td>
<td>Delapil HCl</td>
<td>30 Jan '02</td>
<td>500</td>
</tr>
<tr>
<td>Norcolut</td>
<td>Norethisterone</td>
<td>30 Jan '02</td>
<td>250</td>
</tr>
<tr>
<td>Beacolytic</td>
<td>Bromhexine HCl</td>
<td>30 Jan '02</td>
<td>100</td>
</tr>
<tr>
<td>Ancotil</td>
<td>Flucytosine</td>
<td>30 Jan '02</td>
<td>300</td>
</tr>
<tr>
<td>Kezoral</td>
<td>Ketoconazole</td>
<td>30 Jan '02</td>
<td>100</td>
</tr>
<tr>
<td>Moxipen</td>
<td>Amoxicillin</td>
<td>30 Jan '02</td>
<td>300</td>
</tr>
</tbody>
</table>

Show the drugs when their shelf life is [ ] days from now. 

Figure 11: Expired Drugs List

12 Financial (Daily/Monthly/Yearly incomes)

To view the daily incomes, click Administration → Financial → Daily Incomes. The staff can add incomes and expenses to the list. Besides adding, the staff can also remove the items that are incorrect or accidentally added in. To add a record, fill the Received From and the Amount Received and click Add. The record entered will be displayed in the Daily Incomes list. To remove a record, click on
the record and click **Remove**. The same set of procedure is applied to the expenses.

To view the Monthly and Yearly incomes, click **Administration \(\rightarrow\) Financial \(\rightarrow\) Monthly/Yearly Incomes**. Simply select the duration you wish to view all the incomes and expenses. The total incomes, expenses, and net incomes are calculated and displayed.

### 2.13 Login

For the security purpose, every user of CMIS must login themselves to the system before they can perform their daily responsibilities and tasks. Once the user has double click the CMIS’s icon, the Welcome Page will be displayed. When the application is running, click the **Login** Button that is in the Welcome Page. A new Login window will be displayed and the user need to enter his/her Username and Password, and click **OK**. If the username is not recognized by the system, an error message will popup, indicates that it is not a valid account to enter CMIS. If the password is incorrect, the system will prompt the user to reenter his/her password. Once the correct Username and Password are entered, the Main Page of CMIS is displayed.

If the user decides to exit the system, clicks the **Exit** button that is below the Login button. The system will wait the user’s confirmation to exit the system. Click **Yes** to Exit and **Cancel** to remain in the Welcome Page.

![Login Window](image)

**Figure 12:** Login
14 Low Quantity Drug list

The low quantity drug list will show the drugs that are in critical or minimum units. The list allows the pharmacist to order the drug from the supplier by referring this list. The list is shown in Figure 13. The pharmacist can determine the minimum quantity that the drugs should be listed out.

15 Medical Record

To view the medical record of a patient, the doctor clicks Consultation → Medical Record or click the icon in the Main Page or shortcut key CTRL+M.

There are two major parts in the Medical Treatment window as in Figure 14. One part is the patient’s personal particular and the other is the Diagnosis. The patient can be searched by entering his/her patient ID or IC No. If the patient’s record not
found, an error message pops up. Else, the patient’s personal particular is loaded.

Once the patient is found, some of the buttons are enabled. Click Clear to clear all the fields and perform a new search.

![Medical Treatment](image)

**Figure 14:** Medical Treatment

To view the medical history and previous prescription for the patient, click the Medical History button. If the patient is new patient, two message boxes will pop up showing that no previous medical history and prescription for the patient. The screen captured for the Medical History is as in Figure 15. The medical history and previous prescription can be viewed in this page. Click OK to dismiss the window.
Figure 15: Medical History

To add a current diagnosis to the list, select the disease from the combo box and write down the description. The vital signs and allergies can be added from time to time. Click Add to save the diagnosis to the database for future reference. The diagnosis will be added to the medical history list too.

After the diagnosis is performed, a prescription can be written in the Prescription Writing page. Click the Prescription button to get the page. Any medicine that is prescribed to the patient can be added to the prescription list by filling the prescription, dosage, no times taken daily and etc and click Add To List. To
remove any prescription, highlight the selected prescription and click **Remove From List**. Click **Add to List** to save the prescription so that the pharmacist can refer medicine dispense to the patient (refer Dispensation for details).

For a patient who needs further or extra treatments, an appointment can be made. Click the **Appointment** button and the page displayed. Select a date and a time for the appointment. Write any description for the appointment in the Description textbox. After these are filled, click **Add Appointment** (also refer Appointment List). Click **OK** to dismiss.

If the patient needs a medical certificate or referral letter, click **Print** to perform this action. Choose from the type of document to be printed out. The page is displayed in Figure 16. Click **OK** to start printing.

![Medical Certificate / Referral Letter](image.png)

**Figure 16:** Print Option
2.16 New Patient Registration

When a new patient is the first timer of the clinic, he/she must register to the system so that all his/her records are well managed using CMIS. To register a new patient, click File → New → Patient. A page entitled New Registration is displayed. The patient ID is generated automatically by the system indicates that how many patients are registered to the system. The patient ID starts with 10000 and increments every time a new patient is registered. Minimum three fields that is required to register a new patient that is patient ID, name, and IC No. Other fields can be updated in the future. After at least the three required or all fields are filled up, click Save to save the record in the database. A new record is created for the new patient. Click Clear to clear all the fields and click Cancel to cancel the operation and return to Main Page.

2.17 Patient List

![Registered Patient List](image)

The registered patient in the clinic:

<table>
<thead>
<tr>
<th>PATIENT ID</th>
<th>NAME</th>
<th>IC_NO</th>
</tr>
</thead>
<tbody>
<tr>
<td>10010</td>
<td>Chua Sek Chong</td>
<td>630103056954</td>
</tr>
<tr>
<td>10006</td>
<td>Ahmad bin Muhammad</td>
<td>650218085963</td>
</tr>
<tr>
<td>10008</td>
<td>Lim Ting Ting</td>
<td>690206146984</td>
</tr>
<tr>
<td>10007</td>
<td>Muthu a/Sammy</td>
<td>700105143652</td>
</tr>
<tr>
<td>10019</td>
<td>Lim Lay Tim</td>
<td>710317075941</td>
</tr>
<tr>
<td>10009</td>
<td>Moo Chee Wui</td>
<td>740608085124</td>
</tr>
<tr>
<td>10012</td>
<td>Ngien Sze Ang</td>
<td>751001026351</td>
</tr>
<tr>
<td>10013</td>
<td>Muhammad Hassan</td>
<td>760618048624</td>
</tr>
<tr>
<td>10017</td>
<td>Santhan a/Muthusamy</td>
<td>76120105321</td>
</tr>
<tr>
<td>10005</td>
<td>Goh Guat Choy</td>
<td>770402078563</td>
</tr>
<tr>
<td>10018</td>
<td>Boon Sheue Fuen</td>
<td>780121071129</td>
</tr>
<tr>
<td>10014</td>
<td>Law Yong Sien</td>
<td>780217146348</td>
</tr>
<tr>
<td>10011</td>
<td>Salma bt Omar</td>
<td>780328075542</td>
</tr>
<tr>
<td>10002</td>
<td>Cheong Kok Yan</td>
<td>780410085963</td>
</tr>
<tr>
<td>10016</td>
<td>Lim Lee Peng</td>
<td>780424053257</td>
</tr>
<tr>
<td>10001</td>
<td>Wain Cheunna Leena</td>
<td>78044160195949</td>
</tr>
</tbody>
</table>

Figure 17: Registered Patient List
The patient list displays all the registered patients in the clinic. The patients can be sorted by Patient ID, Name, and IC No. The patient can be deleted too. However, the deletion CANNOT be undoing. So, a deep consideration should be made before deleting any patient. His/her record cannot be restored once it is deleted. The list is shown in Figure 17.

2.18 Patient Profiles

When a patient visits to the clinic, if he/she already is a registered patient of the clinic, the staff will search his/her profiles using Patient Profiles. If the patient is new to the clinic, he/she must register first (refer New Patient Registration for details). To look for a patient’s profiles, click Administration → Patient → Details. Or the staff can click on the icon that resides in the Main Page or shortcut key CTRL+R. A new window entitled Patient Identification is shown in Figure. The patient’s profiles can be search by using his/her patient ID or Identity Card number. Click Search when patient ID or IC No is entered. If the record is not found, an error message pops up indicates that that patient is not found. Else, the patient’s particular is loaded in the Patient Profiles page. The staffs can manage the patient’s record in this page. Click Update if the patient’s record needs to be updated or changed. Click Save to ensure that the update is effective. Always save the record if there are changes. Click Add To Waiting List to add the patient to the Waiting List. (refer Waiting List for details). Click Clear to clear all the fields. The staff can perform another record search once the record is cleared. Click OK button to return to Main Page.
3.2.19 Payment

To receive a payment from the patient, the staff has to proceed with the Payment window. Click Administration → Payment or icon or using shortcut key CTRL + Y to load the Transaction Charge window as in Figure 18. Transaction number is automatically loaded based on the last transaction. Enter the patient’s name in the specified fields. Enter patient name in order to display name in the daily and monthly incomes list (refer Daily, Monthly and Yearly Incomes). Input the charge description and the charge in the textbox provided, click Add to List to add the record to the List of Charge. Remove the item by selecting the record and click Remove from List. The total charge is automatically calculated. Enter the payment received, and the balance will be calculated and displayed. Click Save to save the transaction in the database and a record to the daily, monthly and yearly incomes. If a patient requests for a receipt, click the Cash Receipt to print a receipt for the patient. Click OK to dismiss.
### 3.2.20 Staff Details

The staff’s details can be managed in the Staff Details window. To view the staff details, click Administration → Staff → Details. The details for a staff can be searched by entering the staff’s name or IC No and click Search. Click **Clear** to clear all the fields. Once the staff’s record is found, the **Update** button is enabled. Click **Update** to modify the information in the fields. Click **Save** to make the changes effective.
3.2.21 System Configuration

The information about the clinic is stored in the System Configuration window. To view the system configuration, click Help → System Configuration or using shortcut key CTRL+S. The screen displayed is as in Figure 19. A default value is set for the system configuration. Click Update to change any information about the clinic. The system configuration must be up to date, because other pages may use this information. After changes are made, click Save. Click OK to return to the Main Page.

![System Configuration](image)

Figure 19: System Configuration
2.22 Waiting List

The Waiting List is a list that indicates the waiting queue of the patients to consult the doctor in turn. To view the Waiting List, in the menu bar, click View → Waiting List or press shortcut key CTRL+W or click icon in the Main Page. The doctor can view the count of the patient that are waiting for consultation. Besides, the doctor can view the time they arrived. The Waiting List is shown in Figure 20. The patient is added based on first come first serve. However, the priority is given to the emergency case. Once the patient leaves the clinic or his/her turn is over, the staff or doctor can delete the name in the Waiting List by clicking the Delete button.

![Waiting List](image)

Figure 20: Waiting List
Sample Codes:

```vbnet
' rmDispensation()

Option Explicit

Dim Deduction As Integer
Dim Stock As Integer
Dim result As Integer
Dim decision As Integer
Dim Jumlah As Integer
Dim Pengurangan As Integer

Dim fgTitle As String
fgTitle = "<PRESCRIPTION |<DOSAGE |<DISPENSE |<NO_TIMES_TAKEN"

Private Sub cmdCancel_Click()
Unload Me
End Sub

Private Sub cmdClear_Click()

txtName.Text = ""
txtICNo.Text = ""
txtGender.Text = ""
txtAddress.Text = ""
txtPostalCode.Text = ""
txtCity.Text = ""
txtTelephone.Text = ""
txtPatientID.Text = ""
txtCNoSearch.Text = ""
txtMessage.Text = ""
msRet.Clear
msRet.Cols = 2
msRet.Rows = 2
txtPatientID.SetFocus

End Sub

Private Sub cmdDispense_Click()

msRet.Text <> "" Then

decision = MsgBox("Dispense ", & Trim(msRet.Text) & " ?, vbOKCancel. "Dispensation")

If decision = 1 Then

Pengurangan = msRet.TextArray(msRet.RowSel * msRet.Cols + 2)

strSQL = "SELECT QUANTITY FROM TBL_DRUG WHERE BRAND_NAME = " & msRet.Text & ""
```
Set adrRecordset = New ADODB.Recordset
With adrRecordset
  .Open Source:=strSQL, _
  ActiveConnection:=adcConnection, _
  LockType:=adLockReadOnly, _
  CursorType:=adOpenStatic
End With
If adrRecordset.Fields("Quantity") <> 0 Then
  If adrRecordset.Fields("QUANTITY") < Penguragan Then
    MsgBox "Not Enough Drugs for dispensing!", , "Dispensation"
  Else
    Jumlah = adrRecordset.Fields("QUANTITY")
    Jumlah = Jumlah - Penguragan
    strSQL = "UPDATE TBL_DRUG SET QUANTITY = " & Jumlah & " WHERE BRAND_NAME = " & msRet.Text & ""
    Set adrRecordset = adcConnection.Execute(strSQL)
    msRet.CellBackColor = vbBlue
  End If
Else
  MsgBox "Not Enough Drugs for dispensing!", , "Dispensation"
End If
Else
  MsgBox "Drug not dispensed!"
End If
Else
End If
cmdDispense.Enabled = False
End Sub
Private Sub cmdOK_Click()
  Unload Me
End Sub
Private Sub cmdSearch_Click()
  msRet.Rows = 2
  msRet.Cols = 2
  strSQL = "SELECT * FROM TBL_PATIENT " & _
  "WHERE PATIENT_ID = " & txtPatientID & " OR IC_NO = " & txtICNoSearch & ""
  Set adrRecordset = adcConnection.Execute(strSQL)
"
If adrRecordset.BOF And adrRecordset.EOF Then

MsgBox "Patient not found!", "Dispensation"
txtPatientID.Text = ""
txtICNoSearch.Text = ""
txtPatientID.SetFocus

Else

With adrRecordset
ttxtName.Text = .Fields("NAME")
txtICNo.Text = .Fields("IC_NO")
txtICNoSearch.Text = .Fields("IC_NO")
txtPatientID.Text = .Fields("PATIENT_ID")
txtGender.Text = .Fields("GENDER")
txtAddress.Text = .Fields("ADDRESS")
txtPostalCode.Text = .Fields("POSTAL_CODE")
txtCity.Text = .Fields("CITY")
txtTelephone.Text = .Fields("TELEPHONE")
End With

Set adrRecordset = Nothing

strSQL = "SELECT * FROM TBL_PRESPESCRIPTION WHERE " & 
"PATIENT_ID = " & txtPatientID & " AND DATE = " & Format(Now, "Short Date") & ""

Set adrRecordset = New ADODBC.Recordset
With adrRecordset
.Open Source:=strSQL,
.ActiveConnection:=adrConnection,
.LockType:=adLockReadOnly,
.CursorType:=adOpenStatic
End With

If adrRecordset.BOF And adrRecordset.EOF Then

MsgBox "Prescription " & txtPatientID & " not found!", "Dispensation"
txtPatientID.SetFocus

Else

txtMessage.Text = adrRecordset.Fields("MESSAGE")

msRet.Clear
msRet.FormatString = fgTitle

If adrRecordset.RecordCount > 0 Then

msRet.Rows = msRet.Rows + adrRecordset.RecordCount
Do While adrRecordset.EOF = False

msRet.Col = 0: msRet.Text = adrRecordset.Fields("PRESCRIPTION")
msRet.Col = 1: msRet.Text = adrRecordset.Fields("DOSEAGE")
msRet.Col = 2: msRet.Text = adrRecordset.Fields("DISPENSES")
msRet.Col = 3: msRet.Text = adrRecordset.Fields("NO_TIMES_TAKEN")
adrRecordset.MoveNext
If msRet.Rows > msRet.Row + 1 Then
    msRet.Row = msRet.Row + 1
End If
Loop
End If
End If
End If
End Sub

Private Sub msRet_DblClick()

    msRet.Text <> "" Then

    result = MsgBox("Dispense " & Trim(msRet.Text) & " ", vbOKCancel, "Dispensation")

    If result = 1 Then

        Deduction = msRet.TextArray(msRet.RowSel * msRet.Cols) + 2

        strSQL = "SELECT QUANTITY FROM TBL_DRUG WHERE BRAND_NAME = " & msRet.Text & ""

        Set adrRecordset = New ADODB.Recordset
        With adrRecordset
            Open Source:=strSQL,
            ActiveConnection:=adcConnection,
            LockType:=adLockReadOnly,
            CursorType:=adOpenStatic
        End With

        If adrRecordset.Fields("Quantity") <> 0 Then

            If adrRecordset.Fields("QUANTITY") < Deduction Then
                MsgBox "Not Enough Drugs for dispensing!", vbInformation, "Dispensation"
            Else

                Stock = adrRecordset.Fields("QUANTITY")
                Stock = Stock - Deduction

                strSQL = "UPDATE TBL_DRUG SET QUANTITY = " & Stock & " WHERE BRAND_NAME =" & msRet.Text & ""

                Set adrRecordset = adcConnection.Execute(strSQL)
                msRet.BackColor = vbBlue

            End If
        Else

            MsgBox "Not Enough Drugs for dispensing!", vbInformation, "Dispensation"
        End If

    End If

    cmdSearch.Enabled = False

End Sub

- 139 -
Else
    MsgBox "Drug not dispensed!", "Dispensation"
End If

Else
End If

cmdDispense.Enabled = False

End Sub

Private Sub txtICNoSearch_Change()
If txtICNoSearch.Text <> "" Then
    cmdSearch.Enabled = True
    cmdClear.Enabled = True
Else
    cmdSearch.Enabled = False
    cmdClear.Enabled = False
End If

End Sub

Private Sub txtICNoSearch_KeyPress(KeyAscii As Integer)
    ' Allow the use of the BACKSPACE key
    If KeyAscii = vbKeyBack Then
        Exit Sub
    Else
        KeyAscii = AlphaNumeric(KeyAscii)
    End If

End Sub

Private Sub txtPatientID_Change()
If txtPatientID.Text <> "" Then
    cmdSearch.Enabled = True
    cmdClear.Enabled = True
Else
    cmdSearch.Enabled = False
    cmdClear.Enabled = False
End If

End Sub

Private Sub txtPatientID_KeyPress(KeyAscii As Integer)
If KeyAscii = vbKeyBack Then
    Exit Sub
Else
    KeyAscii = NumericOnly(KeyAscii)
End If
End If

End Sub

Private Sub msRet_Click()
    If msRet.Text = "" Then
        cmdDispense.Enabled = False
    Else
        cmdDispense.Enabled = True
    End If
End Sub